# Contents

## Installation
What's New? ................................................................. 1
About this Guide ......................................................... 1
Glossary ................................................................. 1
System Requirements .................................................. 1
Installing Laplink Gold ............................................... 3

## Introduction and Support
Connecting with Laplink Gold ...................................... 3
Laplink Gold Features .................................................. 4
Getting Help .............................................................. 4

## Connecting
Getting Started: Setting Security and Allowing Others to Connect ... 5
Connecting to Another Computer: Connection Options (chart) ..... 7
Connecting to Another Computer (steps) .......................... 8
Connecting by Laplink Internet ....................................... 9
Connecting by Cable .................................................... 10

## Session Tasks
Microsoft Remote Desktop ........................................... 11
Laplink Remote Desktop ............................................. 12
Remote Control .......................................................... 13
File Transfer ............................................................. 19

## Session Tasks (cont.)
Xchange Agent Synchronization ................................... 24
Address Book ............................................................ 28
Print Redirection ......................................................... 31
Text Chat ................................................................. 32
Voice Chat ............................................................... 33

## Troubleshooting Checklists
Modem Connections ................................................... 34
Dial-up Networking Connections .................................. 35
Network Connections .................................................. 36
Laplink Internet Connections ........................................ 37
Cable Connections ..................................................... 37
CAPI 2.0 / ISDN Connections ........................................ 38
File Transfer ............................................................. 38
Xchange Agent .......................................................... 39
Remote Control .......................................................... 40
Microsoft Remote Desktop ......................................... 41
Print Redirection ......................................................... 42
Text Chat ................................................................. 42
Voice Chat ............................................................... 43
With Laplink Gold’s award-winning remote control, file transfer, advanced connectivity and synchronization features, you can access e-mail, files, and network resources when you’re on the road, work with computer users at other locations, schedule file transfers, print documents to a remote printer, and more.

Laplink Gold for Windows 7 offers you a variety of reliable, easy-to-use options for connecting; simply choose the option that is appropriate for the resources available on your computer and the computer you want to connect to.

What’s New?

Windows 7 Compatibility

Laplink Gold is now Windows 7 compatible! This new version works on Windows XP, Server 2003, Vista, and Windows 7. You can connect to a Laplink computer with an older operating system using Laplink Gold 12 on that system.

About This Guide

This documentation will assist you in using Laplink Gold for Windows 7, acquaint you with its features and operation, and provide a detailed product overview. To improve the usability of this guide, step procedures are located in the online help system. While you are setting up and using Laplink Gold, activate the Quick Steps window and the Laplink help system.

Glossary

Guest: The computer you are using. Regardless of location, the computer initiating an outgoing connection is the Guest computer.

Host: The computer to which you are connecting. It is hosting your connection. Regardless of location, the computer accepting an incoming connection is the Host, since it is allowing the Guest to control it.

Note: Laplink Software also offers Laplink Gold Host for volume license customers who require the ability to gain remote control of Host computers to provide technical support and administration. Laplink Gold Host only allows incoming connections to be completed onto the Host computer(s) by authorized users who have Laplink Gold running on their Guest computers.

Local: Refers to the location of a printer. A “local” printer is connected to its computer.

System Requirements

Before you install Laplink Gold for Windows 7, make sure you have what is needed to connect your computers. To use all of its features and services, Laplink Gold for Windows 7 must be installed on all of the computers you want to connect. Computers with older operating systems can use Laplink Gold 12 instead.

General System Requirements for each Computer

- CPU: 500 megahertz (MHz) or higher processor.
- RAM: Same as minimum required by operating system.
- Available hard disk space: 65 MB.
• Keyboard and mouse required for server installations.

Requirements for Modem Communication
• Modem set up in Windows XP/2003/Vista (with TAPI).

Requirements for Network Communication
• For IPX connections: Microsoft IPX-compatible protocol configured for a network adapter.
• For TCP/IP connections: Microsoft TCP/IP-compatible protocol configured for a network adapter.

Requirements for Dial-Up Networking Communication
• Guest computer: Dial-Up Networking feature of Windows installed, with a Dial-Up Networking connection to a dial-up server.
• Host computer: Running a dial-up server program, or accessible through a dedicated dial-up server that supports incoming Dial-Up Networking connections.

Requirements for Cable Communication
• For USB connections: A Laplink USB 2.0 cable or a Laplink USB 1.1 cable plus a USB port on each computer.
  Note: A Laplink USB 2.0 cable will work in a USB 1.1 port but it will work at USB 1.1 transfer speeds.
  Laplink “Purple” USB 1.1 cables are not supported for Laplink Gold for Windows 7.
• For serial connections: Microsoft Windows XP/Server 2003; a Laplink serial cable and an RS-232 serial (COM) port on each computer.
  Note: Serial cables work in Windows XP and Server 2003 but not in Windows Vista or Windows 7. If you choose to connect by cable on a Vista or Windows 7 machine, you must use a USB cable.

Requirements for CAPI 2.0/ISDN Communication
• An ISDN line and ISDN adapter with a CAPI 2.0-compliant driver on both ends of the connection.

Requirements for Remote Connections:
• Remote Control - Laplink Gold legacy remote option that allows you to connect to Host PCs with older versions of Laplink Gold. The Host PC must be running Windows 2000 / XP / Server 2003 / Vista.
  Note: Remote Control cannot be used on Windows Vista 64-bit operating systems or on Windows 7.
• Microsoft Remote Desktop (RDP) - Microsoft RDP is only available for Laplink Gold Host PCs running:
  • Windows XP Professional, with Remote Desktop Protocol enabled.
  • Windows Server 2003 and Server 2008 Editions with terminal services installed and enabled.
• Laplink Remote Desktop - Allows you to connect to Laplink Gold Host PCs running Windows XP and above. Laplink Remote Desktop is an alternative for those Windows operating systems that cannot use Windows RDP.

Requirements for Voice Chat [must be installed on each computer]
• A sound card or sound device, speakers or headphones, and a microphone [a full duplex sound card driver is recommended].

Installing Laplink Gold
IMPORTANT: You must uninstall any previous versions of Laplink Gold before installing Laplink Gold for Windows 7.

1. Insert the Laplink Gold for Windows 7 CD-ROM in a CD-ROM drive or, if you downloaded Laplink Gold for Windows 7 from the Web, double-click LLGWIN_EN.exe in the folder where you downloaded Laplink Gold for Windows 7.
Connecting With Laplink Gold

Laplink Gold supports multiple connection types. You can configure Laplink Gold for the connections you use frequently, or select your connection when you start Laplink Gold. All that is required is that a version of Laplink Gold (12.02 or higher) runs on both the Guest and Host computers and that your computer is able to make a connection.

Before you can use Laplink Gold to connect to another computer, you must determine how to make that connection using the resources available to the two computers. Once you have setup your connection you can modify or create Address Book entries.

Depending on the resources available on your computer and the computer you want to connect to, you can connect using one of the following:

- **Laplink Universal Serial Bus (USB) cable:** If both computers are in the same location, you can use Laplink’s USB 2.0 cable to link the two computers. Laplink Gold will connect automatically, unless configured otherwise.
  
  Note: Laplink “Purple” USB 1.1 cables are not supported for Laplink Gold for Windows 7.

- **Laplink serial cable** (Windows XP and Server 2003 only): A Laplink serial cable is an alternative cable connection option for those computers that do not have USB ports.
  
  Note: The serial cable option is only available on Windows XP and Server 2003.

- **Laplink Internet:** You can use Laplink Internet to easily and securely connect to other Laplink Gold computers over the Internet. Laplink Internet is accessible to Laplink Gold users who sign up for Laplink Internet accounts and associate their computers to those accounts. This type of connection gives you the full range of Laplink Gold features from any Internet connection. The Host computer must allow Laplink Internet connections and be registered with the service.

- **TCP/IP Network (LAN):** If your office has a network, you can connect to the network via a VPN or other methods, and then to any computer running Laplink Gold on the network. Using the Remote Control service, you can access any network resources normally available to you from the office.

- **Modem:** If your computers are each equipped with a modem, then you can connect them directly. The Host must allow incoming modem connections. Leave Laplink Gold running when you leave the office, and ensure that it can be connected to by modem. Then connect as a Guest to run programs and transfer files as you would normally.

- **Dial-Up Networking:** Use Dial-Up Networking to access a network remotely. By dialing in to a dial-up server (RAS) on the network, you can connect to any computer running Laplink on that network.

- **CAPI/ISDN 2.0 device:** If you have CAPI/ISDN configured on your machine, you can make a connection.
Laplink Gold Features

Once you’re connected, you’re ready to use Laplink Gold’s powerful features:

- **Remote Connections (3 options)**
  - **Remote Control** [Laplink Gold legacy connection option]: The Laplink Gold legacy remote option allows you to connect to Host PCs with older versions of Laplink Gold. You must use Remote Control to make a remote connection to a Laplink Gold Host PC running Windows 2000. Newer operating systems should use one of the two Remote Desktop options.
  - **Microsoft Remote Desktop (RDP)**: RDP is a Windows service that is integrated into Laplink Gold for Windows 7 and offers an enhanced remote control experience. It can be used to connect from any Laplink Gold Guest system but is available ONLY when connecting to Host computers running Windows operating systems as specified in the system requirements (see page 2).
  - **Laplink Remote Desktop** - NEW for Laplink Gold for Windows 7: Laplink Remote Desktop is a new remote connection option in Laplink Gold for Windows 7. It allows you to connect to Laplink Gold Host PCs running Windows XP and above. Laplink Remote Desktop is an alternative for those Windows operating systems that cannot use Microsoft RDP.

*Note: See ‘System Requirements’ (page 2) for operating system restrictions for each remote connection option. See ‘Session Tasks’ (page 11-13) for more information about each option.*

- **File Transfer**: With File Transfer, you can move or copy files between computers. Customizing any of the several File Transfer settings simplifies complicated transfers. Laplink’s patented SpeedSync® technology makes updating files faster because files are compared and only changes—not entire files—are transferred.

- **File Synchronization**: File Synchronization using the Xchange Agent function simplifies the repetitive tasks necessary to keep files updated when you use two or more computers. You can even schedule synchronizations to run unattended. File Synchronization using SmartXchange is the way to fine-tune a specific, one-time synchronization.

- **Print Redirection**: Print Redirection lets you print documents on a printer attached to another computer. You can print a document from a Host computer to your local printer over Remote Control, or print local documents to a printer at a Host location. This means you don’t have to use File Transfer to get documents printed where you want them.

- **Text and Voice Chat**: With Text Chat, exchange real-time messages with someone by typing messages in a window. This is useful if you need to communicate with the person at the other end while performing other services like File Transfer and Remote Control. Text Chat information is saved, and you can also cut and paste text into the Text Chat window.

  With Voice Chat, talk with someone while you perform other services like File Transfer and Remote Control. Voice Chat requires a microphone and sound card on each computer.

*Note: Anti-virus is no longer a supported feature in this version of Laplink Gold. For more detailed information about connecting to another computer, see “Connecting to Another Computer” on page 8.*

To see troubleshooting checklists for each Laplink Gold feature, please see the section starting on page 34 of this Guide.

Getting Help

Laplink Gold for Windows 7 Help Menu

Laplink Gold for Windows 7 also features an online Help system to assist you as you use it. Help is available through the Laplink Gold for Windows 7 Help menu, including:

- **Searchable Help documentation**: Browse Help and use the Help Index and Find features to search for specific information. On the Help menu, click Help Topics.

- **Troubleshooters**: Specify the problem you are having and troubleshooters will walk you through a series of possible solutions. Click Help Topics, then double-click the Troubleshooting book icon.

- **Quick Steps**: Activate the Quick Steps feature to have relevant help appear when you open a dialog box in Laplink Gold for Windows 7. Quick Steps gives you information about the current dialog box and help on how to complete it. On the Help menu, click...
Quick Steps.

- **What's This?**
  Use the What's This? Help to get information about dialog box items. Click the question mark in the upper right hand corner of the dialog box, and then click the item you want help with.

- **F1 Help**
  To get immediate help for an item on a menu, highlight the menu item and press the F1 key.

### Laplink Technical Support

#### Support Options
For technical issues, visit Laplink Technical Support at:
http://www.laplink.com/help

#### Remote Support Interaction
With Laplink’s commitment to its customers, your purchase of Laplink Gold for Windows 7 entitles you to one free remote support interaction to assist you in addressing any questions that may arise during installation, registration, or use of the software.

Note that in order to receive a Laplink Gold for Windows 7 remote support interaction, you are required to have a registered version of Laplink Gold for Windows 7 and a working Internet connection for the PC requiring remote assistance. To schedule a remote support appointment, contact Laplink Customer Service (1-800-LAPLINK). Laplink Technical Support reserves the right to escalate remote support interactions to a direct phone call with a Laplink Representative. Free remote support requests must be made within 30 days of registration.

### Getting Started: Setting Security and Allowing Others to Connect

After you install Laplink Gold for Windows 7, you can make outgoing connections to other computers, but until you change your security settings, other computers cannot access yours except by using a cable (such as a USB cable). To allow incoming connections, change the security settings by creating one or more entries in the Log-in List, or by adding Users from your local Microsoft domain or by allowing public access. You can restrict user access as necessary, specifying who can connect to your computer and what they can see and do once connected.

The safest way to allow incoming connections is to set up password-protected access through the Log-in List. However, you can also set up your computer as a public system, open to anyone who can connect.

### Controlled Access Connections

Laplink Gold for Windows 7 supports two different ways of allowing controlled access to your computer: Laplink Authentication and Microsoft Windows Authentication. Both can be used at the same time.

- **Laplink Authentication** involves creating a log-in list of user names and passwords. A log-in list is unique to the computer on which it is created and it cannot be exported or shared with other Laplink computers. Log-in lists are the best way of creating secure access for individuals.

To specify who can connect to your computer using Laplink Authentication:

1. Go to the **Options** menu and choose **Security**.
2. On the **General** tab, select **Log-in List Only (Protected System)**.
3. Click **Log-in List**, and then click **Add**. The Security Model screen appears.
4. Select **Laplink Authentication** and click **OK**.
5. On the **General** tab, type the Log-in Name and Password the user must provide to connect to your computer.
6. Under **Services**, check the services that you want to make available to the user, such as Remote Control, File Transfer, and Print Redirection.
7. If you’ve checked **Remote Control** as an available service, check the appropriate options under **Locking Permissions** to indicate whether the user can blank your computer screen and disable its mouse and keyboard.
8. Specify any additional user access restrictions and preferences on the **Folder Security** and **Modem Callback** tabs.
9. Click **OK** to add this person to your Log-in List. A Laplink Gold for Windows 7, Gold 2008 or Gold 12 user can now connect to your computer by using the Log-in Name and Password you specified.

- **Microsoft Windows Authentication** is extremely useful for people who are on a Windows Active Directory Network. This feature allows you to give access to network users, so that users need only their network user names and passwords to access the Laplink Gold functions of your computer.

  **To specify who can connect to your computer using Microsoft Windows Authentication:**

  1. Go to the **Options** menu and choose **Security**.
  2. On the **General** tab, click **Log-in List Only (Protected System)**.
  3. Click the **Log-in List** button, and then click **Add**. The Security Model screen appears.
  4. Select **Microsoft Windows Authentication** and click **OK**.
  5. On the **General** tab, select your domain from the drop-down domain list (your current domain will be selected by default).
  6. Select **Users** from the Domain Users area and click **Add** to move them into the Selected area.
  7. Under **Services**, check the services that you want to make available, such as Remote Control, File Transfer, and Print Redirection.
  8. If you’ve checked **Remote Control** as an available service, check the appropriate options under **Locking Permissions** to indicate whether the users can blank your computer screen and disable its mouse and keyboard.
  9. Specify any additional user access restrictions and preferences on the **Folder Security** and **Modem Callback** tabs.
  10. Click **OK** to add the users to your Log-in List. A Laplink Gold user can now connect to your computer by using their network user name and password.

**Public Access Connections**

- You can also open your computer to connections from any Laplink Gold user if you choose. Though public users do not need to enter a password to access your computer, you can limit what they can see and do.

  **To allow public access to your computer:**

  1. Go to the **Options** menu and choose **Security**.
  2. On the **General** tab, click **Anybody (Public System)**.
  3. Click the **Public Privileges** button.
  4. On the **General** tab, check the services you want to make available to public users. If you’ve checked **Remote Control** as an available service, check the appropriate options under **Locking Permissions** to indicate whether the user can blank your computer screen and disable its mouse and keyboard.
  5. To limit public access to particular drives and folders, click the **Folder Security** tab.
  6. Click **OK**.
Connecting to Another Computer: Connection Options

Laplink Gold for Windows 7 gives you a variety of options for connecting to another computer. To choose the appropriate option, determine what resources are available on the local and remote computers.

### Connecting from another Laplink Computer over the Internet

<table>
<thead>
<tr>
<th>Can you connect to the Internet on the local computer?</th>
<th>Can you connect to the Internet on the remote computer?</th>
<th>Then connect to another Laplink computer over the Internet this way:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Use Connect over Laplink Internet for simple, secure connections without the hassle of configuring ports or a firewall.</td>
</tr>
<tr>
<td>No, but I can connect to a network that has an Internet connection.</td>
<td>Yes</td>
<td>Use Connect over Dial-Up Networking to dial into a network server and connect over the network’s Internet connection.</td>
</tr>
</tbody>
</table>

### Connecting over modems, networks, and cables

<table>
<thead>
<tr>
<th>With this available on the local computer</th>
<th>And this available on the remote computer</th>
<th>Connect to another Laplink computer this way:</th>
</tr>
</thead>
<tbody>
<tr>
<td>modem</td>
<td>modem</td>
<td>Use Connect over Modem and dial into the modem on the remote computer.</td>
</tr>
<tr>
<td>modem</td>
<td>modem and network</td>
<td>Use Connect over Modem to connect directly to the remote computer and access all of the network resources available to that computer.</td>
</tr>
<tr>
<td>modem</td>
<td>network with a dial-up server</td>
<td>Use Connect over Dial-Up Networking to dial into the dial-up server and connect to any Laplink computer on the network.</td>
</tr>
<tr>
<td>network</td>
<td>network</td>
<td>Use Connect over LAN (Network).</td>
</tr>
<tr>
<td>serial (only available on Windows XP and Server 2003) or USB port</td>
<td>serial (only available on Windows XP and Server 2003) or USB port</td>
<td>Attach a Laplink serial or Laplink USB cable to each computer. The connection opens automatically. The Belkin USB cable is also a supported USB option.</td>
</tr>
</tbody>
</table>

**Note:** Laplink’s Internet Locator Service (ILS) is no longer an available connection option. Laplink “Purple” USB 1.1 cables are not supported for Laplink Gold 2008.
Connecting to Another Computer

To use all of the features in Laplink Gold for Windows 7, you must first connect to another computer that is also running Laplink Gold for Windows 7. Open the Shortcut Bar and make a selection from the Connect Over menu list, and then provide the connection information (you may use Laplink Gold for Windows 7 to connect to computers running older versions of Laplink, but not all connections and not all features will be available).

**IMPORTANT: Before you can connect to another computer, both computers must be running a version of Laplink, and the connection method you want to use (such as modem, cable or over a network) must be active and available. You may also need a valid Laplink Gold Log-in Name and Password in order to connect, unless public access has been enabled.**

Note: To access the Shortcut Bar when already connected to a Laplink Gold PC, move mouse over the left edge of the main Laplink Gold window and click once. The Shortcut Bar will then open and you can make your desired selection.

**Making a Connection - Options**

How your computer connects to another computer using Laplink Gold depends on the resources available to the two computers. Determine what types of connections each computer is able to make, and then select the appropriate connection option (see chart on page 7 for help in determining your connection options).

To connect to another computer:

1. From the Connect Over menu, select a connection method:
   
   - **Modem:** Using modems and a phone line, you can connect to another computer or to an office network. Use Connect over Modem to dial a modem on the Host computer and open a Laplink Gold connection.

     **Note:** For best results, use only hardware-based modems, such as external (serial) modems. Most internal (software) modems are unreliable for Laplink Gold connections.

     Modem ports must be enabled in Laplink Gold on both computers.

     Choose one of the following to dial a modem connection:

     - Create an Address Book entry, and dial directly from the Address Book.
       
       **Note:** If you added the connection to your favorites, you can connect

     
     - In the Shortcut Bar Connect Over panel, click Modem and choose an entry from the list.

     - Select Connect Over, and then Modem and manually enter the number you want to dial.

     **Note:** Laplink Gold dials the number exactly as you type it, regardless of how you have set up Dialing Properties in other address book entries.

   - **Dial-Up Networking:** Use this method to connect to a network with a dial-up server using a modem. Click the Dial-Up Networking connection you want to use and choose the appropriate dial-up networking options. Click Dial to dial your modem. Once you’ve connected, you will be asked to specify which available computer on the network you want to connect to.

   - **LAN (Network):** Use this method to connect to a computer on the same network. Choose a computer on the network by clicking the computer name. You can also connect to a computer by typing its TCP/IP address. Click the TCP/IP Addresses tab, click Manual Connect, and type the TCP/IP address. Click OK.

   - **Laplink Internet:** Use this method to connect to another computer running Laplink Gold over the Internet. Using this service requires creating a Laplink Internet account.

     **Note:** See additional information about connecting by Laplink Internet in next section.

   - **Cable (USB, Serial):** Use this method for computers connected by one of the Laplink cables. The computer connected to your computer by cable is listed in the Connection list. Click the computer name and click OK.

     **Note:** See additional information about connecting by cable on page 10.

2. From the list of available computers, click on the one to which you want to connect.

3. Under Services, check the services you want to open when you connect (you must check at least one service).
4. Click **OK**.

5. If prompted, type your Laplink Gold log-in name and password.

The connection is made, and the services you selected are opened if the remote computer is set up to allow you to access those services.

### Connecting by Laplink Internet

#### Connecting Through a Firewall

Laplink Internet ensures secure connections and requires no special firewall configuration. To use Laplink Internet, you must first create an account on the Laplink Internet server (first year of Laplink Internet is included at no additional cost).

Once this is complete, you will be able to log-in from any Laplink Gold computer and see any of your other computers that also have Laplink Internet accounts. This applies as long as they are running Laplink Gold and are currently online and available for connections.

#### Creating Laplink Internet Accounts

To create a Laplink Internet account for the first computer:

1. You can set up your Laplink Internet account from the pop-up dialog box that appears automatically when you launch Laplink Gold for Windows 7 for the first time. Simply click **Yes** and follow the instructions presented.

   **Note:** If you choose not to set up your Laplink Internet account at this time, you may go to the “Options” menu, then “Laplink Internet Options” at a later time.

   You can disable or enable the Laplink Internet Service from this screen.

2. Enter the Username and Password for your Laplink Internet account.

   **Note:** Your Laplink Internet Username and Password can be different from your Username and Password for Laplink Gold’s Log-in List.

   IMPORTANT: Now you will need to associate the additional computer(s) to which you will want to connect using Laplink Gold for Windows 7.

To add additional computer(s) to which you will want to connect:

1. Start Laplink Gold for Windows 7 on the computer you want to add.

2. Click **Yes** in the pop-up dialog box that automatically appears asking if you want to register with Laplink Internet.

   **Note:** if you choose not to associate additional users with your Laplink Internet account when you initially set up Laplink Gold on a PC, you may go to the “Options” menu, then “Laplink Internet Options” at a later time.

3. You will be presented with a window.
4. Enter your Username and Password plus a descriptive name for this PC (this is the name that will appear in the Laplink Internet Options dialog box).

5. Click Submit.

You can now connect to and from the computers associated with your account using the Laplink Internet Service.

Connecting by Cable

IMPORTANT: Before you connect the computers with Laplink Gold using cables, you should install Laplink Gold for Windows 7 on both computers.

1. Choose the type of cable—serial or USB—based on the cables and ports you have available and the operating systems running on each machine.

   Ports are the connectors to which you attach cables and peripherals (like printers and external modems). To find out which types of ports are available on the computers you want to connect, consult the documentation or Windows Device Manager for each computer.

   Note: For a serial or USB cable connection, use a Laplink cable. Laplink cables are available at http://www.laplink.com or by calling 1 (800) LAPLINK.

   If more than one type of cable port is available to you, remember that USB is the fastest. A USB cable can transfer data more than 500 times faster than a serial cable. While you can attach a USB cable to any USB peripheral that incorporates a “hub” to which other devices can be connected, we recommend that you plug the USB cable directly into the computer.

2. Once you decide which type of cable connection you will use, attach a Laplink cable to each computer. Attach a Laplink serial cable to a serial port on each computer or a Laplink USB cable to a USB port or USB “hub” device on each computer.

   Note: The Belkin USB cable is also a supported USB option, using the included Laplink drivers. Serial cable option is only available on Windows XP and Server 2003. Laplink “Purple” USB 1.1 cables are not supported for Laplink Gold for Windows 7.


   When you launch Laplink Gold on two computers that are connected by a cable, Laplink Gold connects the computers automatically. If necessary, you can also open a cable connection to another computer manually.

   To manually connect to another computer by cable:

   a. Go to the Connect Over option on the Shortcut Bar menu.

   b. Select Connect over... → Cable (USB, serial).

   c. In the Connection list, select the name of the computer to which you want to connect.
Session Tasks

Note: If already connected to a Laplink Gold PC with at least one Session Task open, you can select additional desired Tasks from the Shortcut Bar.

To access the Shortcut Bar when already connected to a Laplink Gold PC, move mouse over the left edge of the main Laplink Gold window and click once. The Shortcut Bar will then open and you can make your desired selection.

Remote Desktop and Remote Control: Controlling the Remote Computer

Laplink Gold for Windows 7 offers three remote connection options which let you use your Guest computer to perform tasks on another computer, designated as a Laplink Gold Host: Microsoft Remote Desktop (RDP), Laplink Remote Desktop (NEW for Laplink Gold for Windows 7), and Remote Control (Laplink Gold legacy option).

Terminology

When you open a remote control window using any of the connection options, the computer initiating the session becomes the Guest computer and the computer allowing the connection and being controlled becomes the Host computer.

Microsoft Remote Desktop (RDP)

RDP is a Windows service that is integrated into Laplink Gold for Windows 7. It can be used to connect from any Laplink Gold Guest system but is available ONLY when connecting to Host computers running Windows operating systems as specified in the system requirements (see page 2).

Note: Laplink Remote Desktop is an option for those operating systems (Windows XP and above) that cannot use Microsoft Remote Desktop.

• Enabling Microsoft Remote Desktop

In order to use a Remote Desktop connection, Microsoft Remote Desktop must be enabled:

1. Click Start, and then Control Panel. Click System.

2. If you can’t see the System icon, click the Switch to Classic View link in the Control Panel Shortcuts menu.
3. Click the \textbf{Remote} tab and select the \textbf{Allow users to connect remotely to this computer} check box.

4. Ensure that you are either an administrator or a member of the Remote Desktop Users group on your computer.

5. Click \textbf{OK}. For more information on using Microsoft Remote Desktop, consult your Windows online help system.

- \textbf{Host PC Screen Locked}

Once the Laplink Gold Guest computer has made the connection to the Host, the screen on the Host PC will be locked. A local user at the Host PC will be unable to use the computer or see what is happening with the remote session.

\textbf{Note}: The User Name and Password for Microsoft Remote Desktop are the same as your Windows logon credentials for the Host PC.

\textbf{Laplink Remote Desktop (NEW)}

Laplink Remote Desktop is a new remote connection option in Laplink Gold for Windows 7. It allows you to connect to Laplink Gold Host PCs running Windows XP and above. Laplink Remote Desktop is an alternative for those Windows operating systems that cannot use Microsoft RDP.

Unlike Microsoft RDP, Laplink Remote Desktop doesn’t lock the screen of the Host PC, and thus allows you to share the screen with a local user at the Host computer.

\textbf{Note}: The User Name and Password for Laplink Remote Desktop are the same as your Windows logon credentials for the Host PC.

\textbf{Choosing the Remote Desktop Option}

Laplink Gold will automatically choose which Remote Desktop option to use based on your settings. To modify the Remote Desktop settings, go to the \textbf{Options} menu and choose \textbf{Remote Control Options}:

1. Click the \textbf{Remote Desktop Host} tab.

2. To have the option to use both Microsoft Remote Desktop and Laplink Remote Desktop, make sure that both \textbf{Enable Laplink Remote Desktop Host} and \textbf{Allow Connections to Microsoft Remote Desktop Host} are selected.

3. Then, select whether you prefer to use \textbf{Laplink Remote Desktop Host} or \textbf{Microsoft Remote Desktop Host}. If it is not possible to use your preferred choice, Laplink Gold will automatically make the remote connection using the other option. Click \textbf{Apply} and then click \textbf{OK} to save the changes.

\textbf{Connections to Microsoft Remote Desktop Host}

Note: If the Remote PC has allowed you (the Guest PC) access by the log-in list, you will need to enter two sets of credentials when using either of the Remote Desktop options. First, log in to Laplink Gold by entering your Laplink Gold Log-in Name and Password. Then, log on to the Remote PC by entering your Windows User Name and Password.
Remote Desktop Performance Settings

To modify performance settings that affect how the remote session is seen on the Guest PC, go to the Options menu, choose Remote Control Options, and click the Remote Desktop Guest tab. Choose between enhancing your view of the Host screen and speeding up Laplink Gold Remote Desktop performance:

- **Fast Performance**: If your goal is fast performance, then leave the defaults selected so that background wallpaper, patterns, animations and other visual enhancements aren’t shown. You will still see the basics of what you need to access the Host PC.

- **Best View of Host screen**: If your goal is to have the best view of the Host screen, click to clear the check boxes so that the visual enhancements are shown.

Remote Control (legacy)

The Laplink Gold legacy remote option allows you to connect to Host PCs with older versions of Laplink Gold.

**Note:** You must use Remote Control to make a remote connection to a Laplink Gold Host PC running Windows 2000. Newer operating systems should use one of the two Remote Desktop options.

Remote Control provides a way to operate another computer at a distance. While you are working in this window, your mouse moves the mouse pointer on the Host computer, your keyboard types characters on the Host computer, and your Remote Control window shows the Host computer’s screen.

- Technical Support and Help Desk professionals can support their customers remotely.
- You begin Remote Control as soon as you open a Remote Control window.

Fundamentals for the Guest Computer

Because Laplink Gold supports multiple connections, you can open Remote Control sessions on multiple Hosts. Prior to initiating a Remote Control session, make sure the Host you are going to connect to:

- Allows you to initiate a Connection
- Grants you permission to use Remote Control

For more information, see “Getting Started: Setting Security and Allowing Others to Connect” on page 5.

The Host screen appears on your screen as a window within Laplink Gold. The name of the Host computer appears in the window’s title bar. You can move, resize, minimize, or maximize the window as you would any other window. Use the scroll bars to view other parts of the Host screen.
Fundamentals for the Host Computer

When you configure your computer to accept incoming connections, you specify who can connect to the computer and the kinds of services they can use.

• For example, you can limit a Guest to Remote Control only, or you can allow access to Text Chat and File Transfer as well.
• You can allow a Guest to disable your computer’s mouse and keyboard.
• You can leave the Host computer unattended, giving an authorized user exclusive control, or you can stay at the computer and interact with the Guest by trading off control.
  For example, the two of you could:
  • Edit a document together
  • Participate in a training session
  • Explore a new program

When in a Remote Control session, both users can end up competing to control the mouse and keyboard, which can be frustrating and confusing for both parties. To avoid this problem, consider using Host Locking On Connect to disable the Host machine’s keyboard and mouse. See “Disabling the Host keyboard and mouse” for more information.

A Host can be controlled by only one Guest computer at a time. However, other computers can connect using any other services.

What you see on a Host

When a Guest connects and begins Remote Control, your Laplink Gold workspace is minimized on the Host. If you double-click the icon, the Laplink Gold workspace is restored to a window.

At the bottom of the restored Laplink Gold workspace, you see an icon for the Remote Control connection. The icon is identified by the name of the Guest computer. Clicking this icon displays a Windows menu with standard commands. Clicking Close closes the Remote Control connection.

You can make the Laplink Gold workspace remain a window when a Guest connects:
  • Click Remote Control Options on the Options menu, and then click the Host tab.
  • Clear this box: Minimize Laplink When This Computer Is a Host

Reversing a Remote Control session

There may be times when the Guest and you want to switch roles so that you become the Guest controlling the remote computer. To reverse the direction of Remote Control, the current Remote Control connection must be broken on either computer. Then, as the prospective Guest, you open a Remote Control window and begin controlling the other computer.

To avoid breaking the network connection when a Remote Control connection is closed, make sure that there is at least one other service window open, such as File Transfer. If Remote Control is the only service in use, open another service window before closing Remote Control.

On the Guest Computer: Viewing the Host

As a Guest, you can alternate between two views of the Host screen:

• In a window within Laplink Gold (the default)
• As a full-screen display, hiding Laplink Gold and the rest of your Windows workspace

To switch between window and full-screen view, press CTRL+SHIFT+F. In full screen, you can also switch to a window from the copy of Laplink running on the Host. If Laplink Gold is an icon, click it to restore it to a window. Then click the icon representing your Remote Control window, and click Guest Full Screen to clear the check mark.

To make Remote Control solely use full screen and bypass the window view, click Options, and then Remote Control Options. On the Guest tab, check the Always Use Full-Screen box.

• Window View
  • Quick access to File Transfer, Text Chat, and other Laplink features.
  • You can switch to other applications on your computer.
  • Inside the window, you control the Host; outside the window, you perform other tasks, in Laplink or in other applications on your computer.

• Full Screen View
  Viewing the entire Host screen at once: There are two ways to fit the Host screen into your view. For step procedures, see the online help system.
  • From your computer, lower the resolution of a higher resolution Host
screen to match that of your screen.

- Scale the image of the Host screen to fit within your view by pressing **CTRL+SHIFT+S**.

- To maximize the area in which you view and control the Host, switch to a full-screen view. Your entire screen is now devoted to controlling the Host; you do not have access to your own applications.

- When you cannot see the entire Host screen even in full screen, you can change the resolution of the Host screen or scale its image to fit within your view.

**Temporarily changing the resolution of the Host display adapter**

When using a laptop to control a desktop, you often can’t view the entire Host screen at once if the desktop operates at a higher screen resolution. From your laptop, you can lower the desktop’s screen resolution to match your laptop’s. You can then view all of the Host screen in full-screen view. The original resolution is restored automatically on disconnect or at your direction.

**Note:** You cannot lower the resolution of a Host computer unless its monitor and display adapter allow the change without restarting Windows. The Host must also be running a version of Laplink Gold that supports this feature.

**Scaling the image of the Host screen to fit**

You can also view the entire Host screen at once by scaling the image to fit within the Remote Control window. You always see all of the Host’s screen, whether you are working in full screen or window, though the image may be distorted or compressed.

**Customizing keyboard control**

By default, Windows system keys pressed on the Guest computer take effect on the Host. If you want the system keys to operate on the Guest while working in a Remote Control window, select **Options > Remote Control Options > Guest tab > Execute on Guest**. Through Remote Control Options, you can also change the key combinations that control your view of the Host.

- **Windows system keys**

  Windows system keys are key combinations that perform a variety of tasks. Pressing **ALT+TAB**, for example, switches to the program you used last. The Windows Start key found on most keyboards is another example.

  By default, Laplink sends most system keys to the Host during Laplink Remote Control: pressing **ALT+TAB** on the Guest therefore switches to the program last used on the Host. You can make system keys work on your own computer when you are working in a Remote Control window.

  If you intend to control a Host computer using the keyboard exclusively (without a mouse), set the Windows system keys to execute on your computer. When you want the keys to execute on the Host, switch to the full-screen view.

  **Note:** Windows system keys (except **CTRL+ALT+DELETE** and those listed in the next bullet) always take effect on the Host when you are using Laplink Remote Control in the full-screen view.

- **Remote Control shortcut keys**

  Laplink offers two shortcut keys to change your view of a Host screen. Pressing **CTRL+SHIFT+F** switches between full-screen and window view of the Host. Pressing **CTRL+SHIFT+S** switches between scaled-to-fit and normal view.

  You can change these default key combinations to certain other combinations (to avoid interference with other Laplink and Windows shortcut keys, you are limited in your choice of replacements).
Disabling the Host Keyboard and Mouse

From a Guest computer, you can ensure privacy and prevent interruptions at the Host by disabling its keyboard and mouse. To perform these “locking” operations from the Guest, click the appropriate command on the Session menu. On the Host, you must allow locking by changing the default security setup.

• Configuring a Host for locking
You can configure a Host to determine who can lock it and how it will be locked. Guests cannot lock the Host without your permission, and locking privileges you grant cannot be changed during a Remote Control session.

Whether you permit any kind of locking depends on how you intend to use Laplink. If you want to use Text Chat, for example, there should be no locking.

You grant locking permission by changing the security setup on the Host computer. On the Shortcut Bar, click Security, and then choose from the following two options:

• Log-in List (Protected System): Set up a Log-in List by specifying Log-in List (Protected System) and adding one or more entries. In each entry, check any of the three boxes under Locking Permissions. The permissions apply only to Guests whom you provide with the appropriate log-in name and password. For more information about setting up a Login List, see Getting Started: Setting Security and Allowing Others to Connect on page 5.

• Anybody (Public System): If security is not an issue, open the system to any Laplink user by clicking Anybody (Public System). Click Public Privileges, and then on the General tab, check Remote Control box, and then check any of the three boxes under Locking Permissions. The permissions apply to all Guests.

• Locking the Host from the Guest

With the permission of the Host computer, you can:

• Disable the Host mouse: The Host’s mouse is locked, preventing anyone at the Host from using the mouse to interrupt your work.

• Disable the Host keyboard: The Host’s keyboard is locked, preventing anyone at the Host from using the keyboard to interrupt your work.

Note: Through the Address Book, you can request the kinds of locking you want to take effect as soon as you open a Remote Control session.

Your requests will be honored as long as they are allowed by the Host. For information on using the Address Book to make connections, see ’Address Book’ on page 28.

Restarting the Host Computer

• Restarting and logging on to the Host
From a Guest computer, you can restart Windows on the Host computer. To restart a Host from the Guest during Remote Control, click the Reboot Host command in the Session menu. To configure a Host for restarting Windows, click Remote Control Options on the Options menu.

• Restarting the Host from the Guest
From a Guest computer you may want to restart a Host to put into effect changes you have made on that computer. Or you may want to restart a Host computer to ensure that no one else can call in after you disconnect.

To restart the Host from the Guest during Remote Control, go to the Session menu and click Reboot Host.

Note: If ‘Reboot Host’ is dimmed on the Session menu, the Host has not set the option to allow restarting by a Guest.

• Configuring the Host for restarting
You must configure a Host to allow any Guest to restart it during a Laplink Remote Control session. You can also require that the Host be restarted whenever a Remote Control connection is disconnected.

To configure a Host for restarting Windows, go to the Options menu, click Remote Control Options, and click the Host tab. Then select one or both of these check boxes:

• Allow Guest to Reboot on Command: Check this box to allow Guests to restart the Host using the Reboot Host command on their computers.

• Always Reboot When Guest Disconnects: Check this box to require that the Host be restarted whenever a Guest breaks a connection or the connection is broken accidentally.

• Ensuring access to the Host after a Restart
At the same time you are configuring a Host for restarting, you can configure it so
Taking Screen Shots

Laplink Gold allows you to snap a screen shot of the Host computer from the Guest and save it to your hard drive on the Guest computer during a Remote Control session. This is very useful for capturing error messages, odd displays, or other behavior that might be hard to describe. Using the Screen Shot function saves technicians time when troubleshooting.

- **Taking a screen shot**
  To take a screen shot, you must first establish a Remote Control session with a Host computer. Once this connection has been established, select Session, and then click Screen Shot to take a snapshot of the Host desktop.

- **Window or full screen?**
  Laplink allows you to take two different types of screen shots. If you choose Window, you will get a snapshot of the current active window on the remote desktop. Choosing Full Screen will provide you a picture of the entire remote desktop screen.

- **Saving a screenshot**
  Once you’ve taken a snapshot of the screen, you can save it to your hard drive for later viewing. Laplink saves the snapshot as a PNG file, which by default are viewed with Internet Explorer.

**Note:** Internet Explorer 5.0 or higher must be in use in order to view PNG files.

- **Viewing a screen shot**
  To review snapshots you’ve taken, click on the Session menu, and select View Screen Shot. This opens the View Screen Shot dialog, where you can view thumbnail screens of your snapshots, view them full screen, and delete screenshots you no longer need.

  Viewing screenshots is enabled both during a session and when not connected and is the only Session option available when not connected. Once you’ve selected a thumbnail snapshot, and clicked View, Laplink launches Internet Explorer or whatever application your computer has associated with PNG files. If you want to access the PNG files themselves, Laplink Gold saves them to the C:\WINNT\TSI32\LLW directory.

**Saving system information**

Laplink Gold makes it possible to capture important system information already available in Windows on the Host computer, and save it to a file on your local machine. This troubleshooting tool provides your support professionals with a single report offering a great deal of useful information.

Laplink saves all Windows system information from the Host computer, and exports it to your computer. For this reason, you’ll see a dialog asking you where the information should be saved. Indicate a location and the Host computer’s information will be saved as a text file in the indicated location.

- **Creating a report**
  Laplink Gold creates a report that saves your Windows System Information. Below are just a few of the headings of information contained in your Laplink Gold report:
  - System summary information
  - Hardware resources
  - IRQ information
  - Memory
  - Components
  - Audio and Video Codecs
  - Devices
  - Display
  - Keyboard
  - Adapters
Sharing Clipboard Information

Computers in a Remote Control connection share a common clipboard: you can copy or cut information to the clipboard on one computer and paste this information on another. When you cut or copy information for pasting in another document, the information is stored temporarily in the clipboard. Normally, clipboard information is transferred between documents on the same computer. When you use Remote Control, however, you can use the clipboard to transfer information from one computer to another. You can copy text or graphics on the Host computer, for example, and paste it on the Guest.

Only information placed in the clipboard during a Remote Control session can be pasted on other computers. You cannot share any information copied or cut to a clipboard before a Remote Control connection is opened. When you clear the contents of the clipboard on one computer, you clear the clipboard contents of the other computer as well.

- **Pasting from the clipboard during Remote Control**
  When you copy or cut information to the clipboard during Laplink Remote Control, only a small part of the information is transferred to the other computer immediately. The rest of the information is transferred when you paste. To prevent the loss of information added to the clipboard from the remote computer during Remote Control, paste the information before disconnecting. If you are controlling several Host computers, information in the clipboard on your computer is available to any of them. If you want to transfer clipboard information from one computer to another, however, you must first paste the information into a document on your Guest computer; then paste it into a document on another Host computer.

- **Clipboard Sharing**
  By default, clipboard sharing is available during Laplink Gold Remote Control sessions.

Customizing Remote Control Performance

As a Guest, you can change several Laplink Gold Remote Control settings either to speed up performance or to enhance your view of the Host screen. When speed is your priority, change the settings to enhance performance. When you want the best view of the Host screen, turn off the performance enhancements. Choose between enhancing your view of the Host screen and speeding up Laplink Gold Remote Control performance.

To improve Remote Control performance, Laplink temporarily alters the Host screen by removing its wallpaper, screen saver, and other visual enhancements. You can restore any of these enhancements. Or you can improve performance even more by minimizing the number of bitmaps and bitmap colors transferred over a connection.

Go to the Options menu, click Remote Control Options, and click the Performance tab. Then click the Settings button to make advanced changes to how to change the quality of your view of the Host screen without affecting the Host screen itself.

On the Guest Display tab, adjust these options:

- **Send Font Information**: Displays text and symbols on the Guest computer. Checking this box speeds display performance but may not present the most accurate representation of text and symbols.

- **Prevent Display of Large Bitmaps**: Determines the size of the largest bitmap to be displayed in your view, ranging from 32 by 32 to 512 by 512 pixels. Choosing a smaller size improves performance but may cause bitmaps not to appear in some dialog boxes, wizards, and buttons (experiment with the setting, increasing it as necessary to display larger bitmaps).

On the Guest Colors tab, adjust these options:

- **Use Solid Colors**: Displays solid colors instead of dithered, or patterned, colors. Performance is not affected, but your view of the Host may improve.

- **Bitmap Color**: Selects the palette used to display bitmaps. The values range from Monochrome to True Color (24 bit). Choose a palette with fewer colors to improve performance.

- **Temporarily changing the Host screen**: Click the Settings button in Remote Control Options to alter your view of the Host by changing the appearance of the Host screen itself. When you disconnect, the Host screen is restored to its original appearance.
On the Host Display tab, change these settings:

- **Disable Screen Saver**: Keeps the Host’s screen saver from running.
- **Disable Special Windows Effects**: Disables several Windows features, including desktop wallpaper or patterns, animated windows, and Web Page view.

### File Transfer

If you have more than one computer, or if you share data with others, you know how challenging it can be to make sure you have the most recent information. With the File Transfer feature you can quickly move files and folders; it streamlines the process of managing your data.

You can transfer files and folders by dragging and dropping the entire contents. You can manually transfer files and folders, or setup Laplink to do it for you automatically.

File Transfer windows can be opened between a Guest and Host computer or you can use File Transfer to update files on the same computer. Navigate File Transfer windows the same way you navigate in Microsoft Windows Explorer.

**Note:** For basic steps for using the File Transfer service, please see 'File Transfer Steps' on page 22. For step-by-step procedures on how to configure and use the File Transfer service and Sync Tools, see the on-line Help system.

### File transfer terms

**Source**: The selected file or folder.

**Target**: The destination folder into which you are transferring data.

### Updating Files on the Same PC

If you want to transfer files within your computer, open a File Transfer session when you do not have a connection to a Host.

Two File Transfer windows appear, and each window shows the files on your local PC. Using these windows, you can view files in multiple directories on your PC at the same time. Transfer files between directories if desired.

### Configuring File Transfer Options

Certain File Transfer options play a crucial role when you are copying or moving files. Depending on how you set them, you can include or exclude subfolders, prevent the overwriting of files except by newer copies, or copy only files you have backed up before. Before you confirm a copy or move operation, you can change the settings for that operation.

Go to the **Options** menu, and then select **File Transfer Options** to make changes to the settings:

- **Copy/Move tab**

  On the Copy/Move tab, enable or disable File Transfer recovery and choose which verification messages you want displayed.

### File Transfer Recovery - Overview

If you lose your connection to another computer while transferring files, File Transfer Recovery lets you connect again and continue the transfer where it left off. Any file—or portion of a file—copied before the interruption is skipped; only the untransmitted data is copied. If you lose a connection while transferring a file, the data transferred at the point of interruption is stored on the target computer.

- **Only the missing part of the interrupted file is copied.**
• Files successfully copied before the interruption are not copied again. File Transfer Recovery is particularly useful when you copy large files over an unreliable modem connection. To resume an interrupted file transfer:
  • If you were running an Xchange Agent when the interruption occurred, run the agent again.
  • If you were transferring from File Transfer windows:
    1. Re-establish the connection.
    2. Select the same files and folders.
    3. Begin the transfer again.

Configuring File Transfer Recovery

Three options must be enabled for File Transfer Recovery to work effectively. All three appear on File Transfer Options window and are enabled by default.

• Enable File Transfer Recovery: Located on the Copy/Move tab, this box must be checked for File Transfer Recovery to occur.

• Use SpeedSync on All File Transfers: Located on the Performance tab, this box must be checked to allow the transfer to resume with the missing part of a file. When it is cleared, the entire file must be sent again.

• Transfer Only If Files Are Newer: Located on the Filter tab, this box must be checked so that files successfully copied before the interruption are not copied again.

When a transfer is interrupted, File Transfer Recovery creates a file in the target folder containing whatever part of the file has been transferred successfully. The file is named Laplink.tsi.

When File Transfer Recovery resumes a transfer, this file is compared with the source file to determine what’s missing. Once the file is complete, Laplink.tsi is given its original name (if you do not use File Transfer Recovery to resume the transfer, the file remains in the folder and can be safely deleted).

• Delete tab

The Delete tab you determine how you want deleted data to be handled. By default, any files you delete from a hard drive are recycled, that is, moved to the Windows Recycle Bin where you can retrieve them later.

Note: Whether files are recycled or permanently removed is determined solely by the settings on the Guest computer.

• Filter tab

Filter Options are accessible by clicking Options, and then File Transfer Options. Click the Filter Tab and from within File Transfer, click confirmation dialog boxes. Set options on the File Transfer Options Filter tab. These become your default settings. You can modify the default setting each time you transfer files. Confirm the settings, then click OK to continue.

There are three File Transfer options that determine which files are transferred and which are overwritten:

• Transfer Only If Files Are Newer
• Include Subfolders in Copies
• Transfer Only If Files Are Already on Target

The first two options are in effect until you change them.

To change your default preferences for Filter options:

• Select Options, and then File Transfer Options. Click the Filter tab and then check the appropriate boxes.

IMPORTANT: Before transferring files between computers, ensure that their clocks are synchronized. If they are not, files that appear to be older may actually be newer, and you could lose your most recent work.

• Transfer Only If Files Are Newer is designed to preserve files that represent your most recent work. It is also useful for speeding up file transfers; files that do not need to be updated are excluded from the operation.

When the box is checked, Transfer Only If Files Are Newer ensures that files are not overwritten by older copies of those files (files not already on the target will be copied anyway). When the box is cleared, files are overwritten without regard to their dates and times. This must be enabled in order to use File Transfer Recovery.
• Including or excluding subfolders
  - Include Subfolders in Copies is designed for copying a hierarchy of folders and subfolders. It can make the difference between copying hundreds of files or only a few.

  When the box is checked, Include Subfolders in Copies extends your selection to include any subfolders within the folders you have selected. When the box is cleared, your selection is limited to the selected files and folders (including the files in those folders). Subfolders within folders are excluded.

• Transfer Only If Files Are Already on Target simplifies the task of updating older copies of files without adding new ones. It is designed for anyone who regularly updates the same set of files. No matter how many files you select on the source, only those already on the target will be copied; the others will be ignored. In preparation for using this option the first time, copy the files to the target with the box cleared. When you are ready to update the same files, check the box.

For step-by-step procedures, see the online help system. The options on the Filter tab set the default settings to handle file transfers. You can configure these options for each file transfer you perform.

• Performance tab

To improve performance (speed) of file transfers you can configure each transfer to use Laplink’s SpeedSync and Compression.

When you are updating files, SpeedSync can shorten transfer times by sending only the parts of the files that have changed since the last update. SpeedSync is most effective when you update files that have not been changed extensively since the last update. Compression speeds file transfers by “shrinking” files before they are sent and restoring them to their original sizes afterward. Compression is most effective with large files that have not been compressed already. Though both features are in effect by default, there may be circumstances in which you might improve transfer times by disabling them.

• Using SpeedSync

To enable or disable SpeedSync, select Options, and then File Transfer Options. Click the Performance tab.

SpeedSync is designed to cut transfer times when you are updating files. It has no effect when you are copying files that were not on the target before you started copying. Before a file is copied, SpeedSync searches the target for a file with the same name. If none is found, the entire file is copied. Otherwise, the two files are compared to locate changes in the source file. Only the changes located in the source file are copied.

The time necessary to locate changes is usually more than offset by the smaller amount of data that has to be transferred. The reverse may be true in a few circumstances, e.g., when you are updating many small files over a fast connection.

Note: SpeedSync is a tool for decreasing transfer times. It does not merge the contents of two files. The contents of one file will always replace the contents of the other. If you need to merge databases, schedules, or other shared files, see the documentation for the program in which they were created.

• Using compression

To enable or disable compression click Options, and then File Transfer Options. Click the Performance tab. Because compression usually results in the transfer of less data, it is particularly useful when you transfer large files by modem: the larger the files, the greater the savings.

Since compression would actually slow the transfer of files that have already been compressed (or zipped by another file-compression program), Laplink Gold automatically turns this feature off while it is transferring such files.

Note: Whether SpeedSync and compression are used in file transfers depends entirely on the settings of the Guest computer.

• Display tab

On the Display tab you determine how you want new file transfer windows to be displayed, and if SmartXchange statistics are displayed.
Navigating through drives and folders

Each File Transfer window is split into a left and a right side. The left side is designed for navigating through drives and folders: click or double-click a drive or folder to open it and display its contents. On the right side, you see the contents of the open drive and folder. Commands on the View menu let you change the appearance and the order of the contents. Follow these guidelines to navigate through the left side of a File Transfer window:

- Double-clicking a drive or folder opens and expands the drive or folder, displaying its subfolders immediately below. [Double-clicking is the fastest way to navigate downward in a hierarchy of folders.]

- Clicking a drive or folder opens the drive or folder without expanding it.

- Clicking a plus sign (+) expands the drive or folder, displaying its subfolders immediately below. The drive or folder is not opened.

- Clicking a minus sign (-) collapses the drive or folder, hiding its subfolder(s).

Want to locate a particular folder or file? Type the first letter of its name. The highlight moves to the next item beginning with that letter. Typing the letter again finds the next occurrence.

• Changing the view

When you open a drive or folder, you see its contents—subfolders and files—on the right side of the File Transfer window. By default, the contents appear in Detail view: file name, size, type (based on the MS-DOS name extension), modification date, and attributes.

To change the appearance of the items displayed on the right side of a File Transfer window, click View, and then click one of these commands: Large Icons, Small Icons, or List. Try the different views to find your preference. To return to the original view, click Detail.

• Sorting files and folders

Regardless of the view, you can rearrange the folders and files on the right side of a File Transfer window according to name, size, date, and so on. To change the order of files and folders:

- On the View menu, point to Arrange Icons; then click one of these commands: By Name, By Type, By Size, By Date, or By Attributes.

- If you are displaying files in Detail view, you can sort them by name, size, type [file name extension], modification date, or attribute: click the corresponding button at the top of a column. Clicking the same button again reverses the order.

File Transfer Steps

1. **Display the Target**

   To use the drag-and-drop method of copying and moving files, first find your target and make it visible on your screen. A target is the drive or folder you want to transfer the files to.

   1. Identify the target window: it may be the window for your computer or the Guest computer—whichever you want to receive the files.
   2. On the left side of the target window, double-click the target drive.
   3. Click the target folder. Its contents now appear on the right.
   4. If you are looking for a subfolder, click the plus sign (+) beside the folder containing the subfolder. Then click the subfolder itself.

   **Note:** To determine which File Transfer window is which, look for the computer name in the title bar, at the top of each window. In the case of a local-to-local connection, each window will show the same name, followed by a (1) or (2).
2. **Select the Files**

In the opposite File Transfer window, select the files you’ll be transferring to the target you just displayed.

**On the right side of the window, click the folder or file you want to transfer:**

To select a single file or folder:
- Place the mouse pointer on its name or icon, and click the left mouse button.

To select a group of items, do either of the following:
- Click the first item, and press SHIFT while you click the last item.
- Click at a right corner of the group and drag to the opposite corner to form a selection box.

To select two or more items out of sequence:
- Press CTRL while you click the items.

To select all folders and files in the current folder:
- On the **File** menu, click **Select All**.

Using the **Select By** command for files and folders:

1. **On the File menu, click Select By.**

2. In the **Filter** box, type the name of a file or folder. Or use wildcards to specify items with similar names.
   
   For example, typing *.DOC selects all files with the .DOC extension. The default [*.*] selects all files and folders. You can specify several criteria at once by typing them one after another and inserting a space or a comma between them. For example, typing *.DOC,.TXT displays all files with those extensions.

3. If you want to select according to date, check the **Enable Date/Time Range** box. Then type the dates and times under Oldest File and Newest File. Click **OK**.

To clear an individual selection:
- Hold down CTRL when you click the item.

To clear all selections:
- Click **File**, and then click **Clear Selection**.

3. **Drag-and-Drop the Files**

Using the drag-and-drop method simplifies file transfers.

**Note:** Keep in mind the difference between copying and moving. Copying puts a copy of the files on the other computer, leaving the originals where they were. Moving puts the files on the other computer, deleting the originals.

To drag and drop the selected files:
- To copy the files, hold down CTRL and your left mouse button as you drag them to the target folder.
- To move the files, hold down SHIFT and your left mouse button as you drag them to the target folder. If you drag without using CTRL or SHIFT, files are copied when you drag to a different drive or computer and moved when you drag to another location on the same drive.

When you are ready to complete the File Transfer, you will see the File Copy screen:
Smart Xchange: Using File Transfer to Complete a One-time Synchronization

- You can also keep files in specific folders synchronized between computers using the SmartXchange feature. This feature can be accessed by opening a File Transfer connection, selecting the folders to be synchronized on each side, then clicking on the SyncTools menu, and then on SmartXchange.

- Using SmartXchange, you can synchronize two folders on a one-time basis, so that both computers will have the newest version of all files in those folders. Care must be taken when performing this function to ensure that you do not accidentally overwrite files that you do not want overwritten. For information on the Xchange Agent, which allows you to set up recurring synchronizations, see the Xchange Agent Synchronization section that follows.

Creating an Xchange Agent

Once you connect to another computer, you create an Xchange Agent by selecting the pairs of folders—one folder on each computer—which you want to keep synchronized. You can select the pairs from a window displaying the folders on both computers, or you can drag folders from File Transfer windows onto the Xchange Agent window. In either case, you can preview the agent to ensure that you have set up the synchronizations as intended.

- **Xchange Agent wizard**
  The wizard guides you through the process of selecting pairs of folders to be synchronized. After naming and saving the agent file, you can preview the agent and change its settings. To make the files in each folder pair identical, click the Run button on the toolbar.

  **Note:** There are two modes in Xchange Agent: edit and preview. Certain operations are available in one mode and not the other. To save an agent, for example, you must be in edit mode. To change to edit mode from preview mode, click the Close Preview button on the toolbar.

- **New Xchange Agents**
  Choose SyncTools > New Xchange Agent and select the pairs of folders to be synchronized, using one of the following methods:
  - On the Edit menu, click Add Folder Pair. After specifying whether the synchronization is Local-Local or Local-Remote, click a folder on each side of the window. Repeat the procedure to add other folder pairs.
  - Drag folders from File Transfer windows onto the Xchange Agent window. Drag a folder first from one File Transfer window, then from the other one. Repeat the procedure to add other folder pairs.

Once you have selected the pairs to be synchronized, you can do any of the following:

- Preview the agent: Click Preview.
- Name and save the agent file: On the File menu, click Save. In the File Name box, type a name, and click OK.
- Run the agent to make the files in each folder pair identical: Click Run on the toolbar.
• **Running an Xchange Agent**

There are several ways to run a saved Xchange Agent:

- Double-click the agent’s shortcut icon on the desktop. To create a shortcut icon for an open agent, click **Create Desktop Shortcut** on the **File** menu.
- Schedule the agent to run at an appointed time.
- Run the agent from within Laplink. Click **Run Xchange Agent** on the **SyncTools** menu. Then click the name of the agent file and click **Open** (if you saved the Xchange Agent to a location other than the default, you will have to browse to that location).
- Run an agent you have opened in Xchange Agent. Click the **Run** button on the toolbar.
- In Windows Explorer, double-click the agent file. By default, agent files have `.llx` extensions, and are saved to the My Documents folder.

Once an agent finishes synchronizing files, the connection to the Host computer is closed. If Laplink was not running to begin with on the Guest computer, it is shut down automatically.

For a record of your latest synchronizations, refer to the Laplink log file located by clicking **Options**, and then **Logging**, within Laplink Gold.

• **Previewing an Xchange Agent**

Previewing an Xchange Agent lets you see exactly which files and folders will be copied to the other computer, possibly overwriting older versions that already exist there. It also lets you skip pairs of folders and files and resolve conflicts. Unless you specify otherwise, you preview each agent before you run it. You can run an agent from the Windows desktop, from within Laplink, or you can schedule it to run in your absence.

By default, a preview appears whenever you run Xchange Agents. You can also open an agent and preview it.

**Note:** Only agents that you schedule to run unattended will proceed without a preview.

While previewing an agent you can do any of the following:

- Select files or folders to be omitted from the current synchronization only. Click a pair and click the **Skip Pair** button on the toolbar. Skipping a folder skips all the files and subfolders it contains.
  - To select every pair of folders and files in the agent, click **Edit**, and then **Select All**.
  - To locate a pair with a conflict, click the Next Conflict button on the toolbar.

  **Note:** In a preview, arrows indicate the direction in which files will be copied, and thus which files will be overwritten. Special icons indicate conflicts between files.

- Put skipped pairs back into a synchronization - Click a skipped pair and then click **Undo Skip** on the toolbar.
- Resolve conflicts - Click a pair showing a conflict icon, click **Resolve Conflict**, and specify how you want the conflict resolved.

  **IMPORTANT:** Once you have resolved conflicts or marked pairs to be skipped, run the agent before closing the preview. Your modifications will be lost otherwise.

To close a preview, click **Close Preview** on the toolbar. You are now in edit mode. While in edit mode you can customize an agent in several ways.

• **Dealing with conflicts**

When you are keeping folders on two computers in sync, a conflict occurs when a file has been modified on both computers since the last time you synchronized. You can handle these conflicts when you preview or run the agent, or you can set options to handle them automatically.

• **Conflicts between files**

Conflicts occur when you modify a file on both of your computers. Since both files are new, you need to decide how to handle them:

- Copy either the older or the newer file to the other folder, replacing the file already in that folder.
- Copy either the older or the newer file to the other folder and give the file a new name. Nothing is replaced.
• Skip the conflict without copying either file. When you skip a conflict you carry it over to future synchronizations. There are two categories of conflicts:

- New conflicts - Files have been changed on both computers since the previous synchronization.
- Old conflicts - Conflicts were left unresolved in earlier synchronizations. The two computers now have different versions of the same file, and both are dated prior to the latest synchronization. You can either treat these conflicts as new conflicts or ignore them and let both versions remain.

• Changing how all conflicts are handled

Changing how all conflicts are handled

By default, each conflict is presented for resolution when you run an Xchange Agent. You can change this so that conflicts are handled automatically. You can modify the conflict setting from the Xchange Agent’s Properties tab.

- Ignoring old conflicts

Ignoring old conflicts

By default, old and new conflicts are treated alike, according to the settings on the Xchange Agent Properties > Run Options tab. For example, if you specify that conflicts are to be displayed every time you run an agent, old conflicts will appear every time you run the agent. The alternative is to exclude old conflicts, regardless of how other conflicts are handled.

Note: To retain both versions of files in old conflicts, click Exclude Previously Skipped Files on the Advanced tab in Properties.

- Long name conflicts

Long name conflicts

A conflict will occur if you attempt to copy a file or folder with a long name to a drive that does not accept long names. If you do not shorten long names, you are given this choice when you run an agent: either copy the file and give the copy a short name, or skip the conflict without copying the file.

- Conflicts between files and folders

Conflicts between files and folders

A conflict will occur if you attempt to synchronize a file with a folder of the same name. If you do not rename the file to avoid the conflict, you are given this choice when you run an agent: either copy both the file and folder and give the copies new names, or skip the conflict without copying either.

The best way to handle either of these latter two conflicts is to rename files: shorten the long names or rename the file so that it does not conflict with the name of the folder. True synchronization cannot occur otherwise. If you set an agent to run unattended, for example, neither file in a conflict is copied.

• Customizing an Xchange Agent

Customizing an Xchange Agent

Instead of a two-way synchronization, you can customize an agent so that files within folder pairs are copied in one direction only, from one computer to the other. Among other modifications, you can create a shortcut icon to run an agent directly from the desktop, run an agent without a preview, and limit synchronizations just to the files that already appear on both computers.

To customize an agent, you must open it from within Laplink Gold or Xchange Agent.

- Select SyncTools and then Open Xchange Agent. Click the agent file and then click Open.

OR

- In Xchange Agent, select File, and then click Open Xchange Agent. Click the agent file and then click Open.

• Changing the direction of copy

Changing the direction of copy

When you create an Xchange Agent, all folder pairs are set for a two-way exchange of files. Files are copied in both directions until the folders on both computers are identical. You can modify this by specifying that files in a folder pair be copied in one direction only, so that only one folder updates the other. To do this, go into Edit mode and click on the right-to-left or left-to-right arrow, as appropriate.

Note: To customize an agent, you must be in edit mode. If you are previewing, click the Close Preview button on the toolbar.

• Adding folder pairs

Adding folder pairs

With the Agent open, click the Add Pair icon in on the main menu.
• **Deleting folder pairs**

To delete a pair of folders, click the pair and click Delete Pair[s] on the Edit menu. Then click Yes. The folders are deleted from the agent, not from the computers.

• **Changing how an Xchange Agent is run**

There are several ways to customize how an agent is run:

- Create a shortcut icon for running an agent from the desktop: on the **File** menu, click **Create Desktop Shortcut**.
- Schedule the agent to run at the time you want: Select **File**, and then **Schedule**.

You can schedule an Xchange Agent to run at a certain time on the days you specify. Scheduled agents can be configured to run unattended: there is no preview, and conflicts are handled automatically. Xchange agents can be scheduled using the a wizard within Laplink Gold, which uses Windows Scheduled Tasks (Task Scheduler in Windows Vista). To run the agent on schedule, simply leave the scheduler running on the Guest computer.

For more information, consult your Windows documentation.

- Set up the agent to run unattended: Click **File**, and then **Properties**. Then click **Run Options** tab, and then **Run Unattended without Preview or Confirmations**.

  **Note:** A scheduled agent runs without preview, even if you have specified preview on the Run Options tab of Properties. When conflicts are encountered, they are ignored; neither file is copied.

  If you prefer to have the newer file in each conflict copied over the older one, click ‘File’, and then ‘Properties’. In the ‘Run Options’ tab, click ‘Run Unattended’, without Preview or Confirmations. Then click ‘Copy the Newer File over the Older’.

To ensure that an agent runs and synchronizes as scheduled, the agent should originally be created while connected to the host via an Address Book entry. This stores the log-in name and password required by the Guest computer to open the connection.

Determine how conflicts will be handled by clicking either of these options:

- a. Copy the Newer File over the Older
- b. Do Not Copy Either; Keep Both Files

• **Changing which files are included in synchronizations**

By default, subfolders within folder pairs are included in synchronizations. Read-only files are also included, but hidden files and system files are not. To change these settings, click **File**, and then **Properties**. Click the **File Options** tab and change the settings as necessary.

With the File Options tab, you can set an option to limit synchronizations by exchanging only files that already appear on both computers. To exclude files that have been added to one computer and not the other, check the box: Include Files Only If They Are Present in Both Folders.

**Note:** Filters offer another way of determining which files are included in synchronizations.

Instead of changing the various options every time you create a new agent, you can set default options to apply to any agents you create in the future. These defaults will take effect in new agents unless you specify otherwise in Properties. To change the defaults, click **Options**, and then **Properties for New Agents**.

• **Using filters to include or exclude files**

Using preset filters or filters you create yourself, you can limit synchronizations by including only certain files or types of files. Or you can use the same filters to exclude files and file types. Xchange Agent includes filters for some of the most common types of files, including Microsoft Office file types, Lotus 1-2-3, and dBase. File types are defined by one or more extensions. Word files, for example, are defined by the extensions .doc and .dot.

You can also create your own filters for different file types— or for specific files. You can use filters to synchronize only the files matching the filters. Or you can exclude the files matching the filters and synchronize the rest of the files.
Address Book

Laplink Gold’s Address Book offers flexibility and control to users. It allows you to save frequently used connections, create folders, organize your connections, and connect directly from the Address Book. Advanced features include the ability to import and export connection information to and from a global database.

View options and folders

The Address Book provides a folder structure and other options for viewing connections to computers. Laplink Gold allows you to mark Laplink computers you connect to as Favorites when you create address book entries. One click on the Favorites icon in the Address Book tree lists all users you have marked as Favorites in the pane on the right. These might be frequently accessed computers, VIP’s or other connections you want to keep on your Favorites list for easy access. Favorites are also displayed in the Shortcut bar.

- Selecting **All Users** lists all connections you have in your entire address book, including all folders and subfolders.

- Choosing **Global** lists the Global folders. Global folders contain connections that may be accessed by many different users in your organization. For instance, it might be useful to provide a group of connections to your entire tech support team, and another list to your IT team. Global folders can be shared among your teams using the Import/Export features, which will be discussed later in this chapter.

- Choosing **Local** lists the Local folders on your system. Local folders are used to store connections that you wouldn’t need to share with the group. Local folders are not affected by importing or exporting.

Renaming, adding & deleting folders

Laplink Gold allows users to add, rename or delete Address Book folders (folders will only be changed on the machine you are using, not on each Laplink computer). Laplink folders behave just like folders in Windows or Internet Explorer. If you are familiar with how to modify folders, you can skip this section.

- Adding a folder
  To add a folder, select where in your address book you’d like the new folder to appear. Right-click on the location you selected to see your User and Folder options. Choose **Folder**. A new folder will appear under the Global list called New Folder.

- Renaming a folder
  To rename a folder, right-click on the folder you want, and choose **Rename**. Type the new folder name in the box. Once finished, click outside the folder name text box to finish.

- Adding a sub-folder
  It is just as easy to create a sub-folder using Laplink Gold. Simply highlight the folder in which you’d like to create a subfolder, right-click, then choose Folder.

- Deleting a folder
  To delete a folder, highlight the folder, then right-click to view folder options. Select **Delete** to remove this folder.

  **IMPORTANT:** Laplink Gold prompts you with a confirmation screen, but it is important to understand that deleting a folder will delete the folder and all of its contents including any entries in that folder.

Laplink Gold also allows you to Cut-and-Paste a folder, and any connections in the selected folder. You can delete the folder from your Address Book, or paste it to a new location. For instance, you might have a local folder you want to share with your entire team.

Address Book Button Toolbar

The Address Book button bar allows control of user functions in the Address Book. Below is a brief description of the function of each button.

- **Close** - Exits the user from the Address Book.

- **Connect** - Connects you to the selected computer.

- **Add** - Brings up the Add Address Book Entry screen.

- **Edit** - Allows you to edit a selected entry.

- **Delete** - Deletes the selected entry.

- **Find** - Brings up a search interface for finding entries.

- **Setup Global** - Allows for the importing and exporting of a global database.

- **"Add" User Function**
When you add an address book entry to your Favorites, it then appears both in the Address Book favorites list and in the Laplink Shortcut bar. You can have an unlimited number of favorites in the Address Book. However, the Laplink Shortcut Bar displays up to 10 entries.

Clicking Add on the Address Book toolbar opens the “Add Address Book Entry” screen on the General tab. The address book allows you to create and save connections so that frequently used connections can be instantly accessed, without having to redefine the connection information each time.

- **Required Fields**
  
  **Note:** Once these fields contain data, the OK and Connect buttons become enabled, but this does not guarantee a connection. Make sure to use the correct computer name, and that your connection type is correct before attempting to make a connection.

There are four fields in each entry that must be filled in order to save an entry, and for a connection to be possible.

- **General** tab: The Description and Computer Name fields must contain characters.
  
  **Description:** This describes the connection you are making. Laplink Gold automatically populates whatever is typed in the Description field to the Computer Name field, though it is not necessary for these fields to be identical. If you share this entry, the other fields in the top section (Company Name, Job Title, Notes) allow you to further describe the connection for everyone who will use it.

  **Computer Name:** The computer name information entered must exactly match the Laplink name of the computer you’re connecting to and is case-sensitive (you may need to change the name that auto-populated). This is not necessarily the same as the Windows computer name. To see or change the computer name on the host computer you are connecting to, go to the Options menu in Laplink Gold on that machine, and choose Computer Name.

  **IMPORTANT:** You must close all connections prior to modifying a Laplink computer name.

- **Connection** tab: A Connection Type must be selected.

The connection tab allows you to define how you want to connect to this computer. Laplink Gold allows many connection options, and these are discussed in detail elsewhere in this document.

Laplink Gold must be installed and running on both machines. No connection is possible, regardless of connection method, unless Laplink Gold is running on both the Guest computer and the Host computer.

On the Host computer, security must be set to allow a connection. Otherwise, a connection is not possible.

Each connection type has different requirements for connection, and Laplink Gold requires a port to be configured for each connection type. Click Port Setup to configure Laplink Gold to use your different port options.

- **Network: Available Now**
  
  Use this connection type if the computer you are connecting to normally appears in the list of available computers when you use Connect over LAN (Network).

- **Network: TCP/IP Address**
  
  Use this connection type if you want to connect to this computer using a TCP/IP address.

- **Internet Address (Internet Locator Service)**
  
  This connection type uses the address that the host computer has published to the ILS server, such as Jane@ACME.com.

  **Note:** Laplink ILS is no longer available. You will have to use a 3rd-party ILS server if you choose this method.

- **Modem**
  
  Use Modem if you use a modem on your machine to connect directly to a modem on the host machine. Simply enter in the modem number in the Phone Number fields.

- **Cable**
  
  Laplink Gold accepts use of serial (XP and Server 2003 only) and USB cable as connection types.

  **Note:** It is generally not necessary to create an address book
entry for cable connections, as Laplink Gold automatically creates the connection when the cables are attached (by default).

- **Laplink Internet**
  Laplink Internet offers great flexibility by also allowing you to access other Laplink computers using any Internet connection. With Laplink Internet you connect directly over the Internet to your Host with no firewall or VPN configuration required!
  Upon installing Laplink Gold, you were prompted to create a Laplink Internet account. If you did not create an account, you can do so at any time. For instructions on how to do this, please see “Creating Laplink Internet Accounts” on page 9.

- **Services tab**: At least one Service must be selected.
  The Services tab is where you can define what you’ll be able to do once your connection is established. You can choose as few or as many different services as you need.
  
  **Note**: For an explanation of Laplink Gold features, please see page 4.

- **Optional Fields**

  - **Security information to Send**
    If you are connecting to a computer that requires you to login and use a password, enter these pieces of information here.
    
    **Note**: Remember that the password field is case sensitive.

  - **Add To Favorites checkbox**
    Checking this box will allow this entry to be viewed when clicking Favorites on the left Address Book pane and in the Laplink Shortcut Bar.
    
    **Note**: The Laplink Shortcut Bar only displays the first 10 favorites.

- **“Setup Global” User Function**
  For advanced users such as IT professionals, Laplink Gold provides the ability to link to a SQL database through the Address Book. This allows you to create a Global Address book and share this Address Book with anyone in your corporation you choose (provided Laplink Gold is installed on their desktop). This makes it easy to create a single address book and share it with your tech support or IT teams.

  - Click **Setup Global**. The Import/Export window appears. Laplink Gold requires a connection to an SQL database through an ADO string. If you or your administrator know this information, then enter it on the left. Alternatively click the **Build ADO** button, which will bring up the Windows Data Link Properties screen.
    Laplink Gold uses Microsoft’s Data Link Properties utility to step you through the process of connecting to your database. If you have questions about creating this connection, please consult your company’s database administrator.

  - **Importing**
    Importing allows you to download a local copy of the Global Address book. As the Address Book is updated, users may add or delete users or folders. Importing allows you to get any new folders and entries made in your Address Book. Importing and Exporting ONLY affect the Global folders. Connections in your Local folder can’t be shared.
    To share Local addresses, copy them from your Local folders to your Global folders, and then share these connections using Import/Export.
    
    **Note**: To import, you must have read access privileges to the database. See your database administrator for more information.

  - **Exporting**
    Exporting allows you the capability of making changes to your Address Book, then exporting those changes to the database. Exporting is primarily an administrative function.
    
    **Note**: If you’ve made changes to your Global Address list, and you want to share these changes with other Laplink Gold users, you must first use Export to send those changes back to the main database before other Laplink Gold users can import the changes.
    
    **IMPORTANT**: If you make changes to your Global Address Book and then click Export, those changes are permanent, both in your Address Book,
Print Redirection

There are two ways to print over a Laplink connection. While controlling a Host computer, you can print from that computer directly to your local printer. Or, you can reverse direction and print directly from your Guest computer to a Host printer. Either way, you can use Print Redirection to send a document over Laplink Gold to be printed at the opposite end of the connection.

Once you have opened a Laplink Gold connection, you can use Print Redirection to send a document from the computer at one end of the connection to a printer at the other end. There are two ways to use Print Redirection over a Laplink Gold connection:

• **Print from Host to Guest:** While using Remote Control to view and operate a Host computer, you can send a document from the Host computer to a printer at your location. For example, you can prepare a document on your office computer from home and print the document on your home printer.

• **Print from Guest to Host:** When connected to a Laplink Host computer, you can print a document from your computer to a printer attached to the Host. For example, after working on a report at home or on the road, you can connect to your office computer and print the report to a high-quality laser printer in your office.

Without Print Redirection, you’d have to transfer the document to the Guest computer and use a local program to print it locally, or use Remote Control to run a program on the host computer and print the document on the host.

Printing a document over a Laplink connection is much like printing it on a local printer; all you do is choose the Print command. In Print Redirection you select the printer at the opposite end of the connection from the document.

### Requirements for Print Redirection

- You must connect to another version of Laplink that supports Print Redirection.
- The default security setup on the other computer must be changed to allow Print Redirection.
- Both Laplink computers must have the same printer driver (software) installed.

You can control whether a file will print on a remote or local printer regardless of whether the file itself resides on the local or remote computer. This allows you to print in your current location (local) or on a printer attached to the other computer (remote).

### Setting Up Print Redirection

Before you can use Print Redirection, you need to add a printer for Print Redirection to the computer from which you’ll be printing. For example, if you’re remote controlling your office computer and want to print a document on that computer to your printer at home, you need to set up your home printer on the office computer.

The print driver you set up must match the destination printer exactly. Use the same installation method—CD-ROM or downloaded driver—on both computers.

**IMPORTANT:** Using the Printer Redirection wizard in Laplink Gold will not ensure that both computers are using the same printer drivers. For more information about configuring a printer for Laplink Print Redirection, go to [http://www.laplink.com/support/kb/article.asp?ID=36](http://www.laplink.com/support/kb/article.asp?ID=36)

### Setting up a printer

To set up a printer, click **Options**, and then click **Print Redirection Options**. Then click **Setup** to access the **Print Redirection Setup Wizard**. Just as in Windows, you can choose your printer manufacturer and printer name from a list, type a name for your printer, and then click **Finish**.

For step procedures on installing print drivers, see the online help system or...
manufacturer’s documentation.

Once the printer is set up, you can printer to it, and your document is sent over your Laplink connection.

**Note:** In order to print, Laplink must be installed and connected on both computers.

- **Printing Over a Laplink connection**
  
  To print over a Laplink connection, choose the standard Print command in any Windows program and then choose a printer set up especially to receive print jobs from remote computers. The document is then transmitted over the Laplink connection to a printer at the other end.

  When printing from a Host computer to a local printer, choose a local printer from the Host computer using Remote Control. When printing from local to a Host computer, choose a Laplink printer from the local computer. For detailed instructions on setting up and using Print Redirection, see the on-line help system.

- **Printing tips**
  
  There are a couple of items to note when you are using Print Redirection:

  - The Print Redirection icon on the Laplink Gold status bar animates as the document is sent over a Laplink connection to the destination printer. When the animation ends, the document has arrived at the other computer. You can then close Laplink Gold if you want.

  - You can monitor the document print status after it has been sent over a Laplink connection. On the computer to which the printer is attached, click **Windows Start**, point to **Settings**, and click **Printers**. Then double-click the printer icon.

  - You can use Print Redirection over a Laplink connection even when it is not one of the services currently open. Print Redirection is available on demand.

- **Choosing among several printers**
  
  Normally, Print Redirection sends documents to the printer that has been set up as the default printer on the connected computer. If you send a print job from home to the office, for example, the printer designated as the default on the office computer automatically gets the job (if there is only one printer set up on a computer, that printer is always used).

  If you want to use a printer other than the default, you need to set up Laplink to prompt you with a list of available printers whenever you print. Change this setting on the computer the printers are attached to, not the computer with the document. If you’re not in front of that computer, you can still change this setting by using Remote Control.

- **Text Chat**

  Text Chat lets you exchange typed messages with another Laplink user. Text Chat is useful for exchanging brief messages and sending instructions. If you have a microphone, sound card, and speakers, you can also use Voice Chat.

  For step-by-step instructions on using Text Chat, see the on-line Help system.

  To open Text Chat, select the service when you connect to the Host. If you have an active connection Text Chat can be opened from the Window menu or the Shortcut bar.

  **Text Chat options**

  You can configure a Text Chat window to open anytime someone sends you a message. Text Chat is configured from the Options menu.
**Working in Text Chat**

The Text Chat window is divided into two sections. The lower section is where you type your message. Messages are received and displayed in the upper section.

To start a new paragraph, press CTRL+ENTER.

Text Chat supports cut/copy and paste from any text editor. Instead of typing messages while connected, you can prepare them ahead of time and paste them into the Text Chat.

This is especially useful if you have an urgent message to send to multiple Laplink computers.

**Text Chat and Remote Control**

As a Guest during Remote Control, you can carry on a Text Chat conversation with the Host (the computer you are connected to) by viewing the Host screen in a window only (in full-screen view, you cannot see your own Text Chat window). To arrange the Text Chat window beside the Remote Control window, click **Tile Side by Side** on the Window menu.

---

**Voice Chat**

Voice Chat lets you speak with a person at the other end of a Laplink connection using the same line that transfers data between the two computers. Both computers must be configured for full duplex if you are to talk as you would on the telephone. If either computer is configured for half duplex, you must wait for the other person to stop talking before you begin speaking.

---

**Requirements for Voice Chat**

To use Laplink Gold Voice Chat you need:

- A computer that is capable of recording and playing sound
- Microphone
- Speakers or headphones
- Sound card; a full duplex sound card is recommended

**Opening Voice Chat**

For step-by-step instructions on using Voice Chat, see the on-line Help system. To open Voice Chat select the service when you connect to the Host.

If you have an active connection Voice Chat can be opened from the Windows menu or the Shortcut bar. If you have opened a connection to multiple remote computers, select a window for the connection before starting Voice Chat.

**Talking with Voice Chat**

Adjust your speaker and microphone volumes so that you can hear and be heard comfortably. For best performance, use Laplink Gold, not Windows, to control sound levels.

- **Full Duplex**
  
  Depending on the configuration of the sound card in both computers, you may be able to talk as you would on a telephone; that is, your voice and the voice of the other user can be transmitted simultaneously. This is known as full duplex.

- **Half Duplex**
  
  If you and the other user are not using full duplex, you must talk as you would on a walkie-talkie; that is, you must wait for the other person to finish before you begin. The transmission of just one voice at a time is known as half duplex.

Voice Chat conversations are always half duplex unless both sound cards are configured for full duplex.

**Note:** Over slower connections, you may not be able to use full duplex, because of the lower bandwidth of the connection.
• **Talking using half duplex**
  When you are having a half-duplex conversation, refer to the stoplight icon in the lower right corner of the Voice Chat window to know when you can talk. When the light is green or the text says "Talk," you can talk. When the light is red or the text says "Don't Talk," you should wait until the other person has finished talking.
  Saying "over" when you are finished talking may help facilitate conversation.

• **Configuring your sound card for full duplex**
  Some sound cards can be reconfigured for full duplex by updating to new sound card driver software. Contact your sound card manufacturer to find out whether your sound card is capable of full duplex. Updated sound card drivers are usually available on the manufacturer’s website. The sound card of the person you’re talking to also must be configured as full duplex in order for you to talk in full duplex.

• **Improving Voice Chat performance**
  To improve Voice Chat performance, click the Levels tab in the Voice Chat Options dialog box, and then configure the microphone and speaker levels and specify information about your environment.
  Use the Levels tab of the Voice Chat Options dialog box to configure your speaker, microphone, and environment levels.
  For the speaker and microphone levels, click and drag the sliders to the desired level.
  Setting the environment level helps avoid transmitting sound that is not speech. It is recommended that you use the Setup button, and not the slider, to adjust this level.

## Troubleshooting

This section provides checklists for solving problems and improving performance. These checklists are designed as a quick overview of possible solutions. For detailed, step-by-step information, consult the troubleshooters in online Help. The troubleshooters are designed to solve problems you may encounter in opening connections and using the services once you have opened connections.

To use an online troubleshooter, open the Troubleshooting book in Help Topics and display one of the topics. Then answer the questions about your problem and try the suggested remedies. In some cases you will find shortcut buttons to dialog boxes; use these buttons to resolve the problem faster.

**Note:** For an overview of everything available through the Laplink Gold Help Menu, please see the "Getting Help" section on page 4 - 5.

For further assistance, visit: [http://www.laplink.com/help](http://www.laplink.com/help)

In addition to the latest technical information, you’ll have access to the following support options: FAQs, Knowledge Base, Web incident [email] support, live chat support, and fee-based telephone support.

### Checklist for Modem Connections

**Note:** Use a hardware (controller-based) modem, such as an external (serial) modem. Laplink Gold works best when all the functions of the modem are performed on the modem device itself. Use of software-based (controller-less) modems often result in poorer performance and reliability, and may be incompatible with Laplink Gold.

1. **Run Laplink Gold on both computers.** No connections are possible by modem or any other means unless Laplink Gold is running on both computers. You can connect to a computer running Laplink Gold for Windows 7, Gold 2008 or Gold 12.

2. **Ensure that the modem can answer a call or dial out.** A modem cannot answer an incoming call unless the Auto Answer option is on. Click **Options**, and then **Port Setup**. Then click **Windows Modems**. Click **Configure**, and then verify that Enabled under Auto Answer is checked.

3. **Test the modem outside of Laplink Gold.** Does the modem work with other applications? Test the modem with other Windows tools, such as dialing your Internet Service Provider (ISP) or, if you are using Hyperterminal, ensure the modem is working properly.
Shut down the computer and then restart it. Return to Modems in the Control Panel to use Dialing Properties to simplify the dialing process. In the Telephone Number box, type the number exactly as it is to be dialed, including numbers dialed to get an outside line, area codes, country codes, and a “1” when dialing long distance within the United States.

Disable call waiting and answering machines. Ensure that the call waiting feature is disabled on the telephone systems at both ends of the connection. Call waiting and answering machines can interfere with modem connections when incoming calls are detected.

Use Dialing Properties to simplify the dialing process. In the Telephone Number box, type the number exactly as it is to be dialed, including numbers dialed to get an outside line, area codes, country codes, and a “1” when dialing long distance within the United States.

Disable other programs that use COM ports while running Laplink Gold. You may experience problems if you use Laplink Gold to connect by modem while running any other programs that monitor serial (COM) ports. Modem and fax programs, as well as PDA software, typically monitor serial ports for incoming calls or faxes and may cause a modem to disconnect unexpectedly. Disable such programs while using Laplink Gold.

Check the settings for a Windows modem. If your modem does not answer calls or dial after you have enabled it as a Windows modem in Laplink Gold, exit Laplink Gold, and make sure the modem is turned on. In the Windows Control Panel, double-click Modems, click the Diagnostics tab, and click the appropriate port. Click More Info. If the test fails, click the General tab, and remove the modem. Shut down the computer and then restart it. Return to Modems in the Control Panel and reinstall the modem.

Disable error control and data compression on both computers. Some modems communicate better if error control and data compression are disabled on both computers. To disable error control, click Options, and then Port Setup. Click Windows Modems, Configure, and then Properties. On the Connection tab, click Advanced. Then clear Use Error Control. Repeat this procedure on the other computer.

Set a longer timeout value. If the computer you are dialing takes a long time to answer and complete the connection, try increasing its modem timeout. To configure timeout, click Options, and then Port Setup. Click Windows Modems, and then click Configure and Properties. On the Connection tab, type a larger number in this box: Cancel the Call If Not Connected Within.

Lower the modem speed on the computer opening the connection. In Options, click Port Setup, and then click Windows Modems. Click Configure and then Properties. On the General tab, click a lower speed in the Maximum Speed box.

Check the security setup on the remote computer. If you are denied the use of Remote Control or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services by clicking Options, and then Security.

Note: To let other computers connect to your computer by modem, you must change the security setup established during installation. Remember that passwords are case-sensitive.

Ensure that your computer is set up for network connections. Making connections to other Laplink Gold computers through Dial-Up Networking requires that your computer meet the requirements for network connections in Laplink Gold:

- a network protocol must be installed
- your network ports must be enabled in Laplink Gold

Note: To let other computers connect to your computer through Dial-Up Networking, you must change the security setup established during installation.

Note: For more information about Microsoft Dial-Up Networking, consult Windows Help.

Checklist for Dial-Up Networking Connections

Ensure that Dial-Up Networking is installed. You can connect over Dial-Up Networking only if Microsoft Dial-Up Networking has been installed. Dial-Up Networking should already be installed, but if necessary you can install this feature from your Windows CD-ROM as follows: In the Windows Control Panel, double-click Add/Remove Programs. Click the Windows Setup tab, and double-click Communications. If Dial-Up Networking is checked, it is installed. If it is not checked, click Dial-Up Networking, and then click OK to begin installation.

Once connected using Dial-Up Networking, connect to your corporate network. When you connect over Dial-Up Networking in Laplink Gold, you dial in to a remote access server and connect to a network. Then you make Laplink Gold connections to other Laplink Gold computers through Dial-Up Networking. To connect to another Laplink Gold computer once a Dial-Up Networking connection is established, make sure that this box is checked in the Connect over Dial-Up Networking dialog box: After Connecting to the Network, Choose a Laplink Connection.

http://www.laplink.com/help
E-mail us at CustomerService@laplink.com
Tel (USA): +1 (425) 952-6001
Fax (USA): +1 (425) 952-6002
Tel (UK): +44 [0] 870-2410-983
Fax (UK): +44 [0] 870-2410-984
Run Laplink Gold on both computers. No connections are possible by Dial-Up Networking or any other means unless Laplink Gold is running on both computers. You can connect to a computer running Laplink Gold or another Windows-based version of Laplink Gold. Verify that the computer has a network port enabled for the same kind of network connection as your network port.

Use Dialing Properties to simplify the dialing process. In the Telephone Number box, type the number EXACTLY as it is to be dialed, including numbers dialed to access an outside line, area codes, country codes, and a "1" when dialing long distance within the United States.

Disable other programs that use serial (COM) ports while running Laplink Gold. You may experience problems if you use Laplink Gold to connect by modem while running any other programs that monitor serial (COM) ports. Modem and fax software, as well as PDA programs, typically monitor serial ports for incoming calls or faxes and may cause a modem to disconnect unexpectedly. Disable such programs while using Laplink Gold.

Disconnect a Dial-Up Networking connection manually. When connecting by modem, you can instruct Laplink Gold to break a connection after a specified number of minutes in which there is no activity at either end of the connection: Click Connect Options (Options menu). On the Disconnect tab, check the Disconnect Inactive Connections box, and type the number of minutes below.

In most cases, the connection is completely broken after the specified period. With Dial-Up Networking connections, however, you must complete the process: click Disconnect (Connect menu) and then click Disconnect All.

Consult the network administrator to ensure that the RAS server is accessible and responding to connection requests.

Checklist for Network Connections

- Ensure that the network is installed. Laplink Gold cannot connect by network unless a network protocol—either IPX or TCP/IP—is installed. Network protocols are installed using the Networks option in the Windows Control Panel. See your Windows Help and documentation for information on adding network protocols, or consult your network administrator.

- Enable the network port for Laplink connections. Access to a network does not automatically provide network access in Laplink Gold. To connect over LAN [Network] in Laplink Gold, your network port must be enabled—that is, made available for Laplink Gold’s use. To enable a network port in Laplink Gold, click Options, and then Port Setup. Click the type of network—either IPX or TCP/IP—in the Ports list. Then check the Enable Port box. If the network is IPX, click Configure, and ensure that Internetwork Name Broadcast is checked.

- Run Laplink Gold on both computers. No connections are possible by network or any other means unless Laplink Gold is running on both computers. You can connect to a computer running Laplink Gold for Windows 7, Gold 2008 or Gold 12.

- Refresh the list of connections. If Laplink was started on the other computer after you started connecting, you may need to refresh the list of available connections in order to include the computer in the list. Click Refresh List, and wait while the list of Laplink Gold computers is updated.

- Type the password carefully. In Laplink Gold, passwords are case-sensitive. For more information, see the “Getting Started: Setting Security and Allowing Others to Connect” chapter, starting on page 5.

- Type the TCP/IP name or address. If you do not see a computer listed as an available connection over a TCP/IP network, you may have to type the computer’s IP address. Click the Connect button on the LinkBar, and then click Network. On the TCP/IP Addresses tab, type the IP address or the Windows computer name in the TCP/IP Name or Address box. [This name usually differs from the name assigned to the computer in Laplink Gold.]

To determine the TCP/IP address, click Start, and then Run, and then at the command line, type CMD.EXE, and press Enter. Then type IPCONFIG and press Enter. The address appears on the IP Address line. If you cannot connect after typing a TCP/IP address, disable any firewall software on the Host machine.

Note: If you are using an earlier operating system than Windows 2000, please see the guides for Laplink Gold 12.
Check the security setup of the Host computer. If you receive a "not authorized" error message, be sure to change the security setting on the Host from the default of "Private System". Access security settings from the Options menu, then choose Security.

IPX connections: Change the type of frame on both computers. Some IPX connections work better if the frame type for the IPX connection is preset rather than selected automatically; try setting the frame type to Ethernet 802.2 or Ethernet 802.3. This setting should be changed on both computers making a Laplink connection. Network protocols are installed using the Networks option in the Windows Control Panel. See Windows Help and documentation for information on changing the frame type.

Checklist for Laplink Internet Connections

Both computers must be on the Internet and running Laplink Gold. It doesn’t matter how it’s done—by dialing in to an ISP or connecting over a high-speed connection—but both computers must be connected to the Internet before they can connect using Connect over Laplink Internet. Laplink Gold must be running on both computers.

Note: This will not work well over a radio or satellite Internet Connection.

Both computers must be logged on to the Laplink Internet service. On the Host computer, select Options, and then click Laplink Internet Options. On the Guest computer, you can either perform the same procedure or log in with your Laplink Internet user name and password when you connect.

Check the security setup on the Host computer. If you receive a "not authorized" error message, be sure to change the security setting on the Host from the default of Private System. To access security settings, select Options, and then click Security.

Internet connections between computers behind proxy servers may require special configuration. If one or both of the computers is behind a network protected by a proxy server, select Options, and then click Laplink Internet Options. Click Advanced and fill in the proxy server’s authentication information.

Checklist for Cable Connections

IMPORTANT: Different cable types are supported for different versions of Windows. Serial cable: Windows XP and Server 2003 only. USB cable: All Laplink Gold for Windows 7-compatible operating systems.

Note: A Laplink USB 2.0 cable will work in a USB 1.1 port but it will work at USB 1.1 transfer speeds. Laplink "Purple" USB 1.1 cables are not supported for Laplink Gold for Windows 7.

Ensure that Autoconnect is turned on. Autoconnect opens cable connections for you automatically. To ensure that Autoconnect is in effect, click Options, and then Connect Options. On the Connect tab, verify that this box is checked: Enable Autoconnect. Below the option, verify that the services you want to use are also checked. If you have trouble maintaining a cable connection, try disabling Autoconnect on one or both of the computers.

Run Laplink Gold on both computers. No connections are possible by cable or any other means unless Laplink Gold is running on both computers.

Check the cable. Make sure that each end of the cable is securely attached to the proper port; check the port labels for proper identification. Try reconnecting the cable to each port or even reversing the cable ends. Attach a Laplink USB cable to a USB port at each computer. Do not use a non-Laplink USB cable or a USB hub device.

Consult the Windows Device Manager when in doubt about USB or other kinds of ports. If you are not certain whether you have a USB port or another kind of port, check the Windows Device Manager: Rightclick My Computer, and then click Properties. Look on the Device Manager tab, or click the Device Manager button on the Hardware tab. All Laplink USB cables should appear in the Windows Device Manager.

Note: Serial cable connections never appear in the Device Manager.

Enable the port. You cannot connect by cable until a port is enabled—that is, made available specifically to Laplink Gold. To enable a port for cable connections, click Options, and then click Port Setup. Click the port you want to enable. Then check the Enable Port box. If a port is listed as unavailable, quit any program that may be using the port, such as Palm software, fax, and other applications. Make sure that the cable is attached to an available port.
Do not install any separate USB drivers for Laplink USB cables. Laplink Gold has the built-in drivers. If the gold cable has been configured on either computer for use with an older version of Laplink Gold (using USB network drivers), you may experience problems connecting. Contact Laplink technical support for assistance: http://www.laplink.com/help

Serial cable connections: lower the speed of a serial port. In Options, click Port Setup, click the COM port to which the cable is attached. Click Configure. In the Port Speed box, click 57600. Repeat this procedure on the other computer. If you still can’t connect, repeat the procedure, lowering the speed one step at a time until you can connect.

Restart the computer. If all else fails, remove the cable from both computers, and restart the computers. Reattach the cable, and try the connection again.

Checklist for CAPI 2.0/ISDN Connections

Check the security setup on the remote computer. If you are denied the use of Remote Control or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services by clicking Options, and then clicking Security.

Ensure that Laplink Gold is set up to answer calls over CAPI 2.0/ISDN. CAPI cannot answer an incoming call unless the Auto Answer option in Laplink Gold is enabled. In Options, click Port Setup. Then select CAPI 2.0/ISDN, and click Configure. Verify that the Enable box under Auto Answer is checked.

If you are using ISDN in North America, avoid using the Laplink CAPI 2.0/ISDN. In North America, ISDN doesn’t usually include CAPI 2.0 but you can still use your ISDN device in Laplink Gold. If the device is set up as a Windows (TAPI) modem, you can open a Laplink connection using Connect over Modem or Connect over Dial-Up Networking. Simply ensure that the device is enabled as a Windows modem by clicking Options, and then Laplink Port Setup. If your ISDN device is set with its own dialer, use the dialer to log on to a network. Then, in Laplink Gold, use Connect Over LAN (Network) to connect to other computers running Laplink Gold on that network.

Close some Laplink services to allow connections over both channels. Normally CAPI 2.0/ISDN Hosts on which channel bonding is not enabled can handle incoming connections on both channels. When only one connection is possible, try closing services on that connection.

Checklist for File Transfer

Drop files directly on target folder. The most common mistake in drag and drop is dropping files on the wrong target folder (the folder to receive the files). To help prevent this mistake, open the target folder first; the name of the folder now appears in the title bar. Then open the source folder and select and drag the files until the mouse pointer rests on the open folder and the folder is highlighted.

As soon as you release the mouse button, you receive a confirmation dialog box showing, among other things, the target you just dropped on. Check the target, and change it if necessary.

To ensure that files are copied, press CTRL while dragging. To ensure that files are moved, press SHIFT while dragging. If you are copying an entire folder (rather than files within a folder), drop the folder on the target one level higher than where you want the files to appear; this may be another folder or a drive letter. Assume that you want to update your Letters folder on your desktop computer with your Letters folder from your laptop, and the Letters folder appears at the highest level of folders on drive C. Drag the folder from the laptop to the desktop and drop it on drive letter C.

If you have File Transfer difficulties, such as error messages or disconnections, try reducing the amount of data being sent, either by reducing the number of files sent or size of sent files.

Do NOT attempt to move the entire contents [root] of a drive. Windows may create hidden files or folders that could be in use and cannot be transferred.

Likewise, do not attempt to transfer directories containing the Windows operating system. Laplink Gold cannot move any data that has been locked or is in use, such as the Windows Registry. If you wish to ‘clone’ a drive for the purpose of making a bootable operating system on the target drive, use drive imaging software designed for these purposes instead of Laplink Gold.

Note: If you need to copy the entire contents of your computer, try Laplink’s PCmover. More information can be found at: http://www.laplink.com/products.

Use the Copy or Move command. Instead of using drag and drop, use the Copy or Move command. First, click the target folder. After selecting the files to be transferred, click File, and then click Copy or Move. Then verify that the source and target are correct.

Make File Transfer available to other computers. If you are denied the use of File Transfer or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services by clicking Options, and then Security.
Log on to Windows before trying to use File Transfer. As a security measure, Laplink Gold does not allow users to connect to a computer and open File Transfer while the computer is waiting to be logged on to Windows (when you attempt to open a File Transfer connection to a computer running Laplink Gold and displaying the Windows logon dialog box, you see the error message: Creation of window failed). The solution is to open a Remote Control connection first. Log the remote computer on to Windows and then open File Transfer.

Note: To set up Laplink Gold to run before the Windows logon dialog box appears, click Options and choose Program Options. Choose the Advanced tab, and check this box: Always Start Laplink before Windows Logon Prompt.

General tips for faster transfers
Follow these suggestions to improve transfer speeds:
• Check the folders and files you have selected for transfer, making sure that you are not including more than necessary. For example, have you selected an entire folder when you want to transfer only a few files within the folder?
• Use SpeedSync to improve file transfer times when updating files, particularly over modems. On the Performance tab of File Transfer Options, make sure that the Use SpeedSync on All File Transfers box is checked.
• Disable any ports that are not in use. To disable unused ports, click Options, and then 9. Click an unused port, and then clear the Enable Port box.
• Close other service windows and any connections to other computers you may have opened in Laplink Gold.
• On laptop computers, disable power management functions. Attach the AC adapter to the computer to ensure steady voltage throughout the transfer.
• Disable screen savers, and close other programs.
• Serial cables transfer data at 0.4Mbps, while the Laplink Gold USB 1.1 cable can transfer data at up to 5Mbps. For Laplink USB 2.0 cable connections, transfer rates can average 480 Mbps.

Tips for transfers over a serial cable
• Ensure that the serial port is configured for maximum speed. Click Options, and then Port Setup. Select the appropriate COM port. Click Configure and ensure that Port Speed is set at 115200.
• Change the transfer mode to standard. Click Options, and then Port Setup. Select the appropriate COM port, click Configure, and select Standard under Transfer Mode.

Tips for transfers over modems
Consult the documentation for your modem and verify that the port speed is set for optimum performance. Click Options and then click Port Setup. Click Windows Modems, click Configure, select the modem you are using, and then click Properties. In the Maximum Speed list on the General tab, click the maximum speed your modem can use.

Tips for transfers over a network
• Transfer your files when there is less network traffic.
• Ask your system administrator to verify that the network drivers are current.

Tips for SmartXchange
• Use SmartXchange to update files in two folders so that the folders share the latest files. Since SmartXchange always overwrites older files, do not use it if you want to merge the contents of two files. Use SmartXchange by opening the two folders you want to update; do not select the individual files. Click SyncTools, and then SmartXchange. Verify that you have opened the right folders. If you do not want to add new files to either folder, check this box: Transfer Only If Files Are Already on Target.
• Ensure that you have read access rights to network files you want to copy. If you can locate the files you want to copy but then are denied access when you attempt to copy them, contact the network administrator. You can copy only files to which you have been assigned read access.

Checklist for Xchange Agent
• Ensure that Laplink Gold is running on the Host computer. Laplink Gold must be running on the Host computer before an agent can connect to it and synchronize files. On the Guest computer, keep Windows actively running (Laplink Gold will start automatically when the agent runs).
• Change an Xchange Agent schedule in your scheduler program. Once you’ve created an Xchange Agent schedule in Laplink Gold, revise or delete the schedule in the Windows Scheduler program itself.
• Close an Xchange Agent before it is scheduled to run. An agent cannot run on schedule while it remains open in Xchange Agent.
Create an Address Book entry to meet the security requirements of the remote computer. If the remote computer requires a name and password, create an Address Book entry and include the name and password required by that computer. Laplink Gold can then send this information and connect automatically.

Turn off the Laplink Gold callback feature. If the Host computer requires or requests a callback before opening a modem connection, the agent cannot run. On the Host computer, turn off the callback feature: Click the Security button on the LinkBar. On the Log-in List tab, click the name of the Guest computer and then click Edit. Under Modem Callback, click None.

Avoid moving or deleting agent files for which you have created shortcut icons. If you have moved or deleted the Xchange Agent file, the shortcut icon can no longer run the agent. Create the agent again. You can reuse the shortcut icon by saving the new file in the same location, with the same name, as the original file. Or you can create a shortcut icon for the new agent file.

Create a filter to synchronize a single file. Xchange Agent always synchronizes by folder pairs, but you can create a filter so that only one file within a folder pair is synchronized. Open the agent in Xchange Agent and click the folder pair. On the Edit menu, click Set Filter and then click New. After typing a description for the filter, type the complete name of the file, including its extension [to add more than one file name, type a semicolon and then the next file name]. Click OK. Click the filter’s name in the Available Filters list, and then click Add. Preview the agent to see if the correct files are included in the synchronization.

Use Preview to limit the files to be copied in the current synchronization. While previewing an agent, you can specify that certain pairs of files and folders will be omitted from the current synchronization: Click a pair of files or folders and then click the Skip Pair button on the toolbar. Repeat this procedure for any other pairs you do not want synchronized. Then, before closing Preview or quitting Xchange Agent, run the agent. You can also use the option to automatically skip previously skipped items to prevent them from being synched again.

You can omit file and folder pairs only from the current synchronization. To remove them from a future synchronization, you must use Preview again.

Use Xchange Agent to overwrite, not merge, files. Xchange Agent overwrites files. Unless you specify otherwise, it copies the newer file to the other computer. It does not merge files. To merge databases and other shared files, use the program in which the files were created.

Checklist for Remote Control

IMPORTANT: Because Windows Vista does not allow running Laplink Gold as a service, you can restart the Host from a Guest when the Host is running Windows Vista, but that Host will no longer be available to the Guest after the restart.

Improve performance from the Guest. On the Guest, you may be able to speed up Remote Control connections by changing settings. Click Options, and then Remote Control Options on your computer. On the Performance tab, click the Best Performance option [to further customize settings, click the Settings button]. Your view of the Host should be updated faster, though you will now be viewing the Host screen in black and white, and larger bitmaps will not be displayed.

Control the display properties of the Host from the Guest. By default, Laplink is configured to speed up Remote Control connections: any wallpaper or screen saver on the Host is temporarily disabled, along with certain other visual enhancements.

From the Guest, you can restore these enhancements to the Host screen through settings on your computer. In Options, click Remote Control Options, and then click the Performance tab. Select Best Quality [to further customize settings, click the Settings button]. Keep in mind that changing these settings may slow Remote Control connections.

Make Remote Control available to other computers. If you are denied the use of Remote Control or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services through Security [Options menu].

Use the keyboard to view the Host screen. If the window in which you are viewing the Host screen does not show all of the Host screen, you can use your keyboard to view areas beyond the borders of the window: press CTRL+ALT+SHIFT and any of the arrow keys, PAGE UP, PAGE DOWN, HOME, or END.

Use the latest driver for your video adapter. Contact the manufacturer of your video adapter, on its Web site or elsewhere, to verify that you are using the latest driver. New computers do not necessarily ship with the most current drivers installed.

Avoid changing the color depth or display properties of a Host. From the Guest, avoid changing the number of colors displayed on the Host while you’re connected to it using Remote Control. Also avoid changing the Refresh Frequency and other settings in the Host’s Display Properties while connected.

To safely change these properties, you should be seated at the Host and fully informed of the capabilities of its monitor. Incorrect settings can damage a monitor.
Use a special key combination to log on to a Windows Vista, XP or 2003 Host. When you restart a Windows Host, you must press CTRL+ALT+DELETE to log on to Windows again. You can accomplish this from the Guest by pressing a special key combination specified on the Host (pressing CTRL+ALT+DELETE on the Guest affects the Guest, not the Host). To specify a key combination for use on the Guest, start Laplink on the Host and click Remote Control Options (Options menu). On the Host tab, type the key combination in this box: Send CTRL+ALT+DELETE to This Computer When a Guest Presses This Key Combination.

The easiest way to send a CTRL+ALT+DEL to the Host machine is to:

1. Establish a Remote Control session with the Host machine.
2. Click on the Session menu, and select Send CTRL+ALT+DEL to Host.

Do not install other remote control products and Laplink Gold on the same computer. Because of possible incompatibilities, avoid installing Laplink Gold and another remote control product, such as PCAnywhere®, on the same computer.

IMPORTANT: Installing Laplink Gold with another remote control application installed may result in a failure to restart (except in Windows Safe Mode.) For more information on allowing these programs to coexist with Laplink Gold, visit: http://www.laplink.com/help.

Avoid pressing CTRL+ALT+DELETE when viewing a Windows Vista, XP or 2003 Host in full-screen Remote Control. Pressing CTRL+ALT+DELETE on a Windows computer always displays the Windows Security dialog box on that computer. When you are working in a full-screen Remote Control session, pressing CTRL+ALT+DELETE not only displays the Security dialog box locally but also causes the CTRL and ALT keys to be pressed—but not released—on the Host computer. To release these keys and resume normal keyboard operation press CTRL and ALT again.

To have CTRL+ALT+DELETE take effect on a Host computer, click Send CTRL+ALT+DELETE to Host on the Guest’s Session menu.

Keep Laplink Gold running before the Windows Vista, XP or 2003 logon prompt. If you have set up Laplink Gold on the Host computer to run before the Windows logon dialog box appears, avoid closing Laplink Gold on that computer unless you have administrator rights. If you close Laplink Gold, you will have to restart the computer in order to reset Laplink Gold so that other people can connect (restarting Laplink Gold is not sufficient).

Avoid running a Windows Vista, XP or 2003 Host in VGA mode. When a Windows computer is running in VGA mode you can make Laplink connections from it to other computers using Remote Control and File Transfer, but the computer cannot serve as a Remote Control Host. That is, it cannot be remotely controlled by other computers.

Run DOS in a window on a Windows Vista, XP or 2003 Host. You cannot control full-screen DOS programs on a Windows Host. When you attempt to do so, Laplink Gold minimizes the program and displays a warning message (to close the DOS program, right-click the icon, and click Close).

Avoid this problem by setting up the Windows Host to display DOS programs in a window. If you use a shortcut to a DOS program, for example, right-click the shortcut icon, click Properties, and then click the Options tab. Below Display Options, check Window.

Checklist for Microsoft Remote Desktop

Activating Microsoft Remote Desktop on the Host Computer. Before you can connect with Microsoft Remote Desktop, the Host computer must be set to accept Remote Desktop connections.

To activate Microsoft Remote Desktop in Windows:

1. On the Host computer, click Start, and then Control Panel.
2. If your Control Panel is set to display in Category View, click Performance and Maintenance, and then click System. If your Control Panel is set to display in Classic View, click System.
3. From the System dialog box, click the Remote tab.
4. Select the Allow users to connect remotely to this computer checkbox.
5. Click OK.

User account passwords and Remote Desktop. Windows XP Professional and Windows Vista have settings that allow for the creation of user accounts that are not protected by passwords. The Microsoft Remote Desktop feature will not connect to a computer that has no password-protected accounts. If at least one account is password-protected, Remote Desktop will connect and display a login screen. If the account used to log in is not password protected the login is refused and the connection closed.
Checklist for Print Redirection

- **Use the same printer driver on both ends of a connection.** For best print results in Print Redirection, both computers must be set up with the exact same printer driver. To add a printer driver, you may use a disk from the printer manufacturer, or you may be able to download the latest driver from the manufacturer’s website.

- **Use the Windows Control Panel to get additional information.** If the document you printed is sent over Laplink Gold correctly but does not print, examine the printer queue to get additional information about why the document didn’t print (access the printer queue by clicking **Start**, **Programs**, and then **Printers**). Make sure the printer is connected correctly and has enough paper, and the printer cartridge is not empty.

- **When several printers are available, you can set up Laplink Gold to prompt you for the printer to use.** Normally, Laplink Gold automatically directs print jobs to the printer currently set up as the default printer at the other end of the connection. When there are several printers available, however, you may want to use a printer other than the default. To set up Laplink Gold to allow you to choose among the available printers, click **Options**, and then click **Print Redirection Options** on the computer the printers are attached to. Then click **Prompt with a List of Available Printers**.

- **When printing from 16-bit programs, use the default printer.** Before printing from 16-bit Windows programs (programs written for versions of Windows prior to Windows 95, Windows 98, and Guest 4.0), set up the destination printer as the default printer on the computer to which it is attached. When using Print Redirection from the 16-bit Windows program, print to the default printer instead of selecting a printer from the list of available ones.

- **Some printer drivers do not support Print Redirection.** To use Print Redirection you must set up a printer to direct print jobs to a special TSI port instead of the usual parallel port. You cannot use a printer driver that does not allow you to change the port in this way. You may want to contact the printer manufacturer to see if an updated driver is available.

Checklist for Text Chat

- **Press ENTER to send your message.** Type your message in the lower part of the Text Chat window (in some cases, you may have to click in the lower part of the window before you can begin typing). To send your message to the remote computer, press ENTER.

  To begin a new paragraph, press CTRL+ENTER.

- **Open a Text Chat window after connecting.** If you are connected to more than one computer, be sure to specify which computer you want to use Text Chat with: Click the name of the computer on the Window menu. Then click the **Open Text Chat** button on the Shortcut Bar or **Open Text Chat** in the Windows menu.

- **Make Text Chat available to other computers.** If you are denied the use of Text Chat or one of the other services while connected to another computer, check the security setup on that computer. You can gain access to services by clicking **Options**, and then **Security**.

- **Save your Text Chat conversation from time to time.** As a Text Chat conversation grows in length, the most recent messages begin to replace the earliest. This starts to happen when the conversation exceeds 32,000 characters. If you intend to save a lengthy conversation, begin saving before this limit is reached. To save a conversation, scroll to the upper part of the Text Chat window, click **Edit**, and then **Select All**. Then click **Edit**, and then select **Copy**. You can then switch to another Windows program such as Notepad, paste the text, and save it as a file.

- **Shorten connection time by preparing messages beforehand.** Instead of typing text while connected, you can prepare it ahead of time in Notepad or a similar Windows program and send it to a remote computer through Text Chat. In the other application, select the text, and press CTRL+C to copy. In the lower part of the Text Chat window, press CTRL+V to paste. Then press ENTER to send.

- **Use File Transfer for long messages.** Text Chat can send as many as 2,048 characters at once. When you attempt to send a message that exceeds that limit, part of the message will not be transmitted to the other computer. Try sending the message in parts. Or save the message as a file, and send the file using File Transfer. You can still use the Text Chat window to let the remote user know what you’re sending and to pass along additional notes.
Checklist for Voice Chat

- **Use full duplex sound card drivers on both ends of the connection.** Voice Chat is easiest to use over a full duplex connection; you can hear and be heard at the same time, as on the telephone. For full duplex, both ends of the connection must have sound cards with drivers that support full duplex. Contact your sound card manufacturer to determine whether your sound card supports full duplex; and find out whether drivers are available. When using half duplex, wait for the other person to finish talking.

  A common problem in half duplex conversations is knowing when to start talking. Use the stoplight icon in Laplink Gold as a guideline for when you can talk and when you can’t. In some cases, a verbal signal that you are finished speaking (saying “over,” for instance) might be helpful, or it might help to simply pause a few seconds when you are done speaking.

- **If you’re using Manual mode, be sure to release the walkietalkie button.** You might not be able to hear the other person otherwise.

- **Adjust your microphone to a comfortable level.** Many microphones require adjustment in order to send clear speech. Make sure your microphone is placed at a good distance from your mouth—not too far and not too close—and then adjust the microphone level. Click **Voice Chat Options**, and then use the **Levels** tab.

- **Adjust your speakers or headphones to a comfortable level.** Most speakers, and some headphones, have a manual control that you can use to adjust volume. It is recommended that you leave the manual controls at a medium level, and adjust the volume of speakers and headphones in Laplink Gold. For best results, adjust the Laplink Gold sound levels, not those available in Windows.

- **Minimize background noise, if possible.** Try moving your microphone away from telephones, loud computer power supplies, radios, and so on. Move your speaker and microphones farther apart. If the person you’re talking to hears a lot of noise in your background or doesn’t hear your voice, you might want to reset your environment level by clicking **Voice Chat Options**, and then use the **Levels** tab.

- **Tips for improving Voice Chat performance.** Perform a test by clicking **Voice Chat Options**, and then selecting **Levels** tab to get the best performance. Adjust transmission quality to match the conditions of the connection: In the Options menu, click **Voice Chat Options**, and then select the **Advanced** tab. Click **Low** if you are talking over a modem or other slow connection. Click **High** if you are talking over a network or other fast connection.